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A Return Authorization (RA) number must be obtained from

the factory and clearly marked on the outside of the package

before any material will be accepted for warranty adjustment.

Johnson Yokogawa Corporation will pay the shipping costs of

returning to the licensee items which are covered by warranty.

Johnson Yokogawa Corporation believes that the information

in this manual is accurate. The document has been carefully

reviewed for technical accuracy. In the event that technical or

typographical errors exist, Johnson Yokogawa Corporation

reserves the right to make changes to subsequent editions of

this document without prior notice or transmittal to holders of

this edition. The reader should consult Johnson Yokogawa

Corporation if errors are suspected. In no event shall Johnson

Yokogawa Corporation be liable for any damages arising out

of or related to this document or the information contained in

it.

EXCEPT AS SPECIFIED HEREIN, JOHNSON YOKOGAWA

CORPORATION MAKES NO WARRANTIES, EXPRESS

OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY

WARRANTY OF MERCHANTABILITY OR FITNESS FOR

A PARTICULAR PURPOSE. JOHNSON YOKOGAWA

CORPORATION WILL NOT BE LIABLE FOR DAMAGES

RESULTING FROM LOSS OF DATA, PROFITS, USE OF

PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL

DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY

THEREOF. This limitation of the liability of Johnson

Yokogawa Corporation will apply regardless of the form of

action, whether in contract or tort, including negligence. Any

action against Johnson Yokogawa Corporation arising out of

this license, must be brought within one year after shipment of

the software covered hereby. Johnson Yokogawa Corporation

shall not be liable for any delay in performance due to causes

beyond its reasonable control. The warranty provided herein

does not cover damages, defects, malfunctions, or service

failures caused by licensee’s failure to follow the Johnson

Yokogawa Corporation installation, operation, or maintenance

instructions; licensee’s modification of the product; licensee’s

abuse, misuse, or negligent acts; and power failure or surges,

fire, flood, accident, actions of third parties, or other events

outside reasonable control. In no event shall Johnson

Yokogawa Corporation’s liability hereunder exceed the price

paid to Johnson Yokogawa Corporation for this license.

Copyright

Under the copyright laws, this book may not be copied,

photocopied, reproduced, or translated, in whole or in part,

without the prior written consent of Johnson Yokogawa

Corporation.

Trademarks

VARILINK™ is a trademark of Johnson Yokogawa

Corporation.

Product names listed are trademarks of their respective

manufacturers. Company names listed are trademarks or trade

name of their respective companies.

BY OPENING THE SEALED DISK PACKAGE, YOU

AGREE TO BE BOUND BY THE TERMS OF THIS

AGREEMENT, WHICH INCLUDE THE SOFTWARE

LICENSE AND THE LIMITED WARRANTY (collectively

the “Agreement”). THlS AGREEMENT APPLES TO YOU

AND ANY SUBSEQUENT LICENSEE OF THIS

SOFTWARE PROGRAM (“software”).

IF YOU DO NOT ACCEPT OR AGREE TO THE TERMS OF

THIS AGREEMENT, DO NOT OPEN THE DISK PACKAGE

. PROMPTLY RETURN THE UNOPENED DISK PACKAGE

AND ALL OTHER MATERIAL IN THIS PACKAGE WITH

PROOF OF PAYMENT TO THE SOURCE WHERE YOU

OBTAINED THE PRODUCT FOR A FULL REFUND.

Johnson Yokogawa Corporation retains ownership of the

enclosed program. This program is licensed to you for use

under the following conditions:

Permitted Uses / You May:

Use the software on any compatible computer, provided you

use the software on only one computer at a time.

Use the software on a network, file server or virtual disk

provided that access is limited to one user at a time and that

you have the original copy of the documentation and the

program disks.

Permanently transfer the software to another user if you

transfer the documentation and all disks and the other user

agrees to the terms and conditions of this Agreement.

Prohibited Uses / You May Not:

Make copies of the documentation or program disks, except as

described in the documentation.

Loan, rent, sublicense, or otherwise transfer the software or

the documentation, except as provided above.

Alter, modify or adapt the software or documentation,

including, but not limited to, translating, decompiling,

disassembling, or creating derivative works.

This license and your right to use the software automatically

terminate if you fail to comply with any provision of this

license agreement. Upon termination you will destroy all

documentation and disks.

Johnson Yokogawa Corporation retains all rights not expressly

granted. Nothing in this Agreement constitutes a waiver of

Johnson Yokogawa Corporation’s rights under the U.S.

Copyright laws or any other federal or state law.

Limited Warranty

Johnson Yokogawa Corporation warrants that for a period of

90 days after shipment, the software supplied hereunder will

meet Johnson Yokogawa Corporation’s published functional

specifications. Johnson Yokogawa Corporation will, at its

option, repair or replace software media that do not execute

programming instructions if Johnson Yokogawa Corporation

receives notice of such defects during the warranty period.

Johnson Yokogawa Corporation does not warrant that the

operation of the software shall be uninterrupted or error free.

© 1994 Johnson Yokogawa Corporation
Printed in U.S.A.

Yokogawa Corporation License Agreement
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This manual is a tutorial and user guide for Johnson Yokogawa’s VARILINK™ Recorder Interface
Software (Version 1.4). VARILINK™ dynamically interfaces Johnson Yokogawa industrial recorders
with personal computers (PCs) for data acquisition and remote programming.

This software allows PC users to retrieve and display process data directly from µR1000, µR1800,
µRlOOT, µRlOOF, µRl80T, HR2400 and HR2500E recorders as well as the DA2500 data acquisition
terminal. The software runs on any IBM compatible PC equipped with an RS232C port or an
RS422A port. Users can send or retrieve data to and from the recorder by:

◊ direct RS232C or RS422A cable link between a desktop or laptop PC and the recorder, or;

◊ downloading information to a disk for transport/storage.

This VARILINK™ manual is divided into six chapters covering step by step instructions for each
recorder product (line):

1. µR1000 Dot Model Hybrid Strip Chart Recorder

2. µR1800 Dot Model Hybrid Strip Chart Recorder

3. µR1000/µR1800 Pen Model Hybrid Strip Chart Recorders

4. HR2400 Hybrid Recorder

5. HR2500E Hybrid Recorder and DA2500 Data Acquisition Terminal

6. µRlOOT, µR180T and  µRlOOF Hybrid Strip Chart Recorders

Each chapter takes the user through every step of the configuration process, from recorder setup to
computer setup. The manual is a tutorial showing every KEY STROKE in the process and an
accompanying EXPLANATION of each entry.

The following typefaces are used in this manual to help the user distinguish between the different
types of keystrokes involved in the setup procedures:

TYPEFACE SIGNIFICANCE

Times Roman Normal Used to signify normal instruction text within this document.

HELVETICA ALL CAPS Used to signify the recorder display seen by the user at each
stage of the tutorial.

Courier Norma1 Used to signify the computer screen display seen by the user at
each stage of the tutorial.

Times Roman Italic Used to signify an example actually typed by the user under
the KEY STROKE column during the tutorial.

If you need assistance, please call Johnson Yokogawa at 1/800-524-SERV (TAC Group).

Preface
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µR1000 Dot Model

Software Limitations

VARILINK™ 1.4 performs data acquisition for the µR1000 Dot Model strip chart recorder. Items
in the Setup Mode of the recorder cannot be set from VARILINK™ 1.4. Refer to Instruction
Manuals IM 4D5B1-01E and IM 4D5B1-10E for a detailed explanation of items in the Setup
Mode.

The clock in the recorder cannot be accessed or set through VARILINK™ 1.4.

The following items can be configured from VARILINK™ 1.4: Ranges, Alarms, Zones, Partial,
Print Format, Tags, Messages, Chart Speeds, Math Channels, Constants and Engineering Units.

Exceptions: 1)  The constant 1E + 29 may not be entered through this software.
2)  10Ω  copper RTD inputs cannot be configured via VARILINK™.

Requirements

1. IBM or compatible computer;
2. DOS 2.1 or higher;
3. Johnson Yokogawa Corporation VARILINK™ 1.4 software;
4. Recorder with RS422A:

a. Refer to  IM 4D5B1-01E
b. If computer is equipped with a RS232C port, a RS422A to RS232C converter is

required.

Recorder Setup

KEY STROKE EXPLANATION

< Enter > Power-up recorder while pressing < Enter > on the recorder panel.
Refer to Parameter Display and Contents for setting information.
SETUP is displayed, ALARM is flashing

< � > Until OPT (option) is displayed and flashing
< Enter >

OPT= is displayed, COMM is flashing
< Enter >

ADDRESS= is displayed, 01 is flashing
< � > Select a number (01-16). See note below.
< Enter >

BAUD RATE= is displayed
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< � >< � > Select 9600
< Enter >

D. LEN= (data length) is displayed
< � >< � > Select 8 DATA BITS
< Enter >

PARITY= is displayed
< � >< � > Select NONE
< Enter >

STOP BIT= is displayed
< � >< � > Select 1
< Enter >

*COMM SET* is displayed
< Enter >
< ESC > To return to setup display
< � >< � > Until END is displayed
< Enter >

END = STORE is displayed
< Enter > Settings are complete

Caution: Do not turn off power to the recorder while information is being stored. The recorder will

reboot automatically.

Note: Device #1 = Address 1, Device #2 = Address 2, etc.

Computer Setup

Boot up computer on DOS and install Johnson Yokogawa Corporation VARILINK™ software in
your disk drive.

KEY STROKE EXPLANATION

VARILINK™ < Enter > After a moment, the Main Menu will appear as follows:
< Fl > Display & Data Acquisition Menu.
< F2 > Edit Configuration.
< F3 > Setup Computer.
< F4 > Save All Setup Parameters.
< F5 > Save Configuration From Recorder.
< F6 > Load Configuration to Recorder.
< F7 > HR2400 IC Card.
< F8 > HR2400 reports.
< F10 > End Program.
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From Main Menu

KEY STROKE EXPLANATION

< F3 > Setup Computer
< Fl > Setup Com Ports
< F2 > Select Devices
< F10 > Prior Menu

KEY STROKE EXPLANATION

< Fl > Setup Com Ports
< Enter >
< F1 > change Com Port 1
< F2 > change Com Port 2
< F3 > change Com Port 3
< F4 > change Com Port 4

Repeatedly pressing the appropriate function key will scroll the various Baud Rate choices.
(Minimum = 300, maximum = 9600). Select the appropriate rate.

Then press:

< F10 > Prior Menu.

From Setup Computer Menu

KEY STROKE EXPLANATION

< F2 > Select Devices.
Enter number of device to be edited:

< Enter > Select Devices Menu appea rs.
< F2 > Device Number:
< F3 > Device Type:
< F4 > Start Channel:
< F5 > End Channel:
< F6 > Interface:
< F7 > Address:
< F10 > Prior Menu

Note: For Data Display and Acquisition, device types are limited to only those devices which

are connected to the computer. Failure to do so will create a program error. A maximum

of 144 devices may be selected. A maximum of 1200 input channels may be selected.
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KEY STROKE EXPLANATION

< F3 > Device type: press repeatedly until µR1000 appears.
< F4 > Start Channel:

Enter new starting channel number: (sequential order,
lowest contiguous channel)

< Enter >
< F5 > End Channel

Enter new ending Channel: (sequential order, highest
contiguous channel)

< Enter >

Note: < F4 > and < F5 > functions only pertain to data acquisition and data display of

information.

< F6 > Interface; press < F6 > repeatedly to select Com Port (this i s the
Com Port on your computer to which you have connected the µR1000
dot model recorder, Com 1 through Com 4).

< F7 > Address: Press < F7 > repeatedly until  you reach the address set
during the recorder setup procedure.

Note: The address setting must match the setting in the recorder. For more information, refer to

the recorder setup for the µR1000 Dot Model.

< F10 > 3 times Return to MAIN MENU. The computer is now Setup for
communications with the µR1000 dot model recorder.

< F4 > Save All Setup Parameters.

Display and Data Acquisition Menu

From Main Menu

KEY STROKE EXPLANATION

< Fl > Display & Data Acquisition Menu.
Setup Data Acquisition Menu will appear.

Setup Data Acquisition

< Fl > Help
< F2 > Sampling rate: (seconds)
< F3 > Filename to store data to: (your file name)
< F4 > File type:
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< F5 > Number of rows in data file: (samples per
channel)

< F6 > Number of columns in data file: (number of
channels)

< F8 > Save All Setup Parameters
< F9 > Start Main Program (start Display or Data

Acquisition).
< F10 > Prior Menu

Note: Spreadsheet software places a limitation on the number of columns that are available for

use in data acquisition. The limit is 250 columns or, as used in VARILINK™ 1.4, a total

of 250 Channels. When the number of channels to be acquired exceeds 250,

VARILINK™ 1.4 will automatically write multiple files to disk to accommodate the

excess over the 250 limit. See Example #1 below.

The ability to write multiple files simultaneously could also be used to segregate data as

desired. See example #2 below.

Example 1: Selected Devices 1 through 42 are µR1000 Dot models with 6 channels each
and 252 total points. All other devices are set NA.

Set number of columns in data file to 250 (max allowed), File name = TEST.
VARILINK™ 1.4 will save the data to 2 separate files.
File Name #1 will be TESTA00.WKl (Inputs 1-250).
File Name #2 will be TESTB00.WKl (Inputs 251-252).

Example 2: Selected devices 1, 2, 3, 4 and 5 are µR1000 Pen Models with 4 points each
and 20 total points. All other selected devices are set to NA.

Set Number of columns to 4, File name = DATUM.
VARILINK™ 1.4 will save the information to 5 separate files.
File Name #1 will be DATUMA00.WK1 (Recorder #1)
File Name #2 will be DATUMB00.WKl (Recorder #2)
File Name #3 will be DATUMC00.WKl (Recorder #3)
File Name #4 will be DATUMD00.WK1 (Recorder #4)
File Name #5 will be DATUME00.WK1 (Recorder #5)

Note: The maximum number of files that can be created is 14.

Example 3: Selected Device #1 is a µR1000 Dot Model with 6 Channels. Channels 1, 2 &
3 to be saved in one file and Channels 4, 5 & 6 to be saved in a different file.
Data samples every 30 seconds. Number of samples per point is 1000. File
name is TEST. All other Selected Devices are set to NA.

See the following data entries.
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KEY STROKE EXPLANATION

< Fl > Help screen for Data Acquisition.
< F10 > To return Main Menu.
< F2 > Sampling rate. This setting is in seconds: minimum setting is 2

seconds, maximum setting is 21,600 seconds or 6 hours. This setting
determines how often data is saved from the recorder to the file.

30 < Enter >
< F3 > Filename to store data to: Enter complete path and your

own file name with a maximum of 5 characters.
Test < Enter >
< F4 > File type: you have 2 choices: .WKl (Lotus spreadsheet format)

or .DIF (Data interchange format). This is accomplished by pressing
< F4 > (each time you press < F4 > .WKl and .DIF will toggle on the
screen).

< F5 > Number of rows in data file: minimum 500, maximum
8,180. This is the number of samples of each acquired channel to be
stored in each file.

1000 < Enter > 1000 samples of each acquired channel will be taken before a new file
is created.

< F6 > Number of columns in data file: minimum 1 column,
maximum 250 columns. (Number of columns equals number of
channels.)

2 < Enter > File #1 name: TESTA00.WK1 (Channels 1, 2 & 3)
File #2 name: TESTB00.WK1 (Channels 4, 5 & 6)

< F8 > Save All Setup Parameters: this will save the settings < F2 >
through < F6 > to the default file for Data Acquisition.

< F9 > Start main program. The computer screen will display
Testing Communications. Also, at the bottom left of the screen
you will observe data being read from the µR1000 dot model recorder.
After approximately one minute, Main Data Menu will appear.

 Main Data Menu

< Fl > Display Data
< F2 > Data Acquisition
< F3 > HR2400 IC Card
< F10 > Main Menu
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Display Data

KEY STROKE EXPLANATION

< F1 > Display data.
 < � >< � > To scroll through channels, use these keys.
< Page Up >
< Page Down > Scrolls pages of channels.

Note: You may move directly to a given channel by typing that channel’s defined tag name.

< F10 > Return to Main Data Menu.

Data Acquisition

KEYSTROKE EXPLANATION

< F2 > Data Acquisition.
Start/Stop Data Acquisition Menu will ap pear. At this
point in the program, you may change any of the parameters < F2 >
through < F6 > described in the Data Acquisition Menu
section discussed earlier.

< Fl > or To start Data Acquisition.
< F10 > Return to Main Data Menu.

If < Fl > was selected
< F1 > Stop Data Acquisition when Data Acquisition is complete.

Note: The number of samples taken is displayed in the lower left portion of the screen. Also,

the current file is displayed to the right of samples taken. Once a file is full, the program

will create another file automatically. A maximum of 224 files will be created. However,

if disk space is depleted, program will stop.

File creation Example: File name = Test
Current File: Test?00 will appear; once this file is full, the current file:

Test?01 will appear.

Note: After Data Acquisition is complete, the Menu will return to Start/Stop Data
Acquisition. If < Fl > is pressed and the file name has not been changed, a box will

appear under < F10 > Prior Menu: Do you want to overwrite the
existing files (Y/N). If Y is selected, the current file will be overwritten.

KEY STROKE EXPLANATION

< F10 > Return to Main Menu.
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Edit Configuration

From Main Menu

Save Configuration from Recorder

Note: A configuration file must be in the default directory before "Edit Configuration" can

begin.

If you have a new disk or a disk that does not have an existing file:

KEY STROKE EXPLANATION

Note: Configuration files are .PNL extension files.

< F5 > Save configuration from recorder.
Select recorder to save data from.

< Enter >
Test < Enter > Enter File name to save configuration to

(without extension)

Note: VARILINK™ 1.4 will save data from all channels of the recorder to the default

operating directory.

Screen will flash WORKING. When Save Configuration is complete, program
will return to MAIN MENU. The recorder display will be left in " MANUAL"
mode.

Edit Configuration
From Main Menu

KEY STROKE EXPLANATION

< F2 > Edit Configuration.

Edit Menu

Select Instrument to Edit

< F1 > HR2400
< F2 > HR2500
< F3 > µR1000/1800
< F10 > Prior Menu
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Temperature Units

KEY STROKE EXPLANATION

Select ºF or ºC.
< F1 > ºF.
< F2 > ºC.

Note: This selection does not change recorder setup for temperature. The change can only be

made in the Setup Mode of the recorder. If you do not have temperature inputs, select

< Fl > ºF.

Edit µR1000 Dot Model Configuration

Enter the file to be edited.

KEY STROKE EXPLANATION

Test < Enter > Checking Input File for errors will appear. If file is not
corrupted, Edit Menu will appear.

Note: If you have a file error, resave your file from recorder. (Refer to save configuration from

recorder.)

Edit Menu

Select item to be edited.

< Fl > Ranges, Tags, Units, Printout, Alarms, Zones
and Partials

< F2 > Chart Speeds, Print, Messages and Daylight
Savings Setting(optional)

< F3 > Math Channels, Tags, Units, Printout and Alarms
< F4 > Math Constants
< F10 > End Edit

For an explanation of items < Fl > and < F2 >, refer to  IM 4D5B1-01E. < F3 > and < F4 >, refer to
IM 4D5B1-20E.
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Ranges, Tags, Units, Printout, Alarms, Zones and Partials

KEY STROKE EXPLANATION

< Fl > Ranges, Tags, Units, Printout, Alarms, Zones
and Partials. Channel will be highlighted.

< � >< � > Select c hannel to be edited. Select from channels 1-6. (For example:
Stop on Channel 1.)

< Tab > Mode will be highlighted.
< � > Change input type. (For example: Stop on Volt.)

The following items may be selected:

Volt Voltage ranges from 20mV to 50 volts DC
TC (Thermocouples) Select from R, S, B, K, E, J, T, L, U, N or W
RTD (Resistance thermal detectors) Select from Pt or JPt
Delta For measurement channels greater than #1
Scale Volt Voltage ranges from 20mV to 50 volts DC
Scale TC Select from R, S, B, K, E, J, T, L, U, N or W
Scale RTD (Resistance thermal detectors) Select from Pt or JPt
Square Root Voltage ranges from 20mV to 50 volts DC
DI (Digital Input) Level or Contact
Math (Math)
Skip (Channel off)

KEY STROKE EXPLANATION

< Tab > Range will be highlighted.
< � >< � > Change input type for TC, RTD, DI or Range Value for volts.
< Tab > Left Span will be highlighted. This is left span (0% value).
1 < Enter > Low end input value.
< Tab > Right Span (100% value).
5 < Enter > High end input value.
< Tab > Tag will be highlighted.

Type in Tag Name. (maximum of 7 characters) (For more information,
refer to IM 4D5B1-01E, Table 8.1 Characters)

FT-101 < Enter > After all characters have been entered

Note: If you choose to turn the scaling on, you will need to perform the next section. If scaling

is off, TAB will go to Alarm.

< Tab > Left Scale will be highlighted.
0.0 < Enter > Left scale value.
< Tab > Right scale will be highlighted:
100.0 < Enter > Right scale value.
< Tab > Units will be highlighted. (maximum of 6 characters) (For more

information, refer to IM 4D5B1-01E, Table 7.3 Characters)
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Tons < Enter >
< Tab > Alarm 1 will be highlighted
< � >< � > To turn Alarm Off or select H=High, L=Low, RH=Rate of change

high, RL=Rate of change low. If off, setting is complete.
< Tab > Setpoint 1 will be highlighted
50 < Enter > Select Set Point value.
< Tab > Relay 1 ID will be highlighted.

Note: Although choices range from I01-I24, the relay selection for the µR1000 Dot Model is

limited to I01-I06. The recorder must be equipped with /A1 (2 relays), /A2 (4 relays) or /

A3 (6 relays) for the setting to be valid.

< � >< � > Turn relay Off or select from relays I01-I06. If “Off” is selected,
setting is complete.

< Tab > Alarm 2 will be highlighted
(Repeat as above for Alarms 2 through 4).

< Tab > Left Zone will be highlighted. Set Value. (minimum)
0 < Enter >
< Tab > Right Zone will be highlighted. Set value. (maximum)
100 < Enter >

Note: The minimum width of a zone is 5mm. The maximum setting is 100mm. For more

information on Zones, refer to µR1000 Dot Model  IM 4D5B1-OlE.

< Tab > Partial will be highlighted.
< � >< � > Turn Partial On or Off.

If On is selected proceed as below. If Off, setting is complete.
< Tab > Percent will be highlighted.

Set percentage.
25 < Enter >
< Tab > Boundry will be highlighted.

Set value.
10 < Enter >
< Tab > To edit other channels or,
< F10 > To return to µR1000 Dot Model Edit Configuration

Menu.

For more information on Partial, see µR1000 Dot Model  IM 4D5B1-OlE.

Charts, Print, Messages and Daylight Savings Setting

 KEY STROKE EXPLANATION

< F2 > Chart Speed 1 will be highlighted.
< � >< � > Scroll to select chart speed.
25 < Enter > Set Chart Speed.
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< Tab > Chart Speed 2 will be highlighted. (See Note)
Set Chart Speed.

< Enter >
< Tab > Print will be highlighted
< � >< � > Select auto or fix.
< Enter >
< Tab > Message 1 will be highlighted.
< Enter > Input message to be displayed. (For more information, refer to IM

4D5B1-01E, Table 8.2 Characters)
< Tab > Message 2 will be highlighted.

Repeat as above for messages 2-5.

Note: The daylight savings settings are only available if the recorder is equipped with the

Daylight Savings option. For more information on this option refer to IM 4D5B1-50E.

< Tab > Daylight Mode will be highlighted.
< � >< � > Select Winter or Summer.
< Tab > Daylight Date will be highlighted.

Type in YY/MM/DD HH. Hours range from 00 to 23.
< Enter >
< F10 > Prior Menu.

Math Channels, Tags, Units, Printout and Alarms

KEY STROKE EXPLANATION
< F3 > Math Channels, Tags, Units, Printout and

Alarms. Channel will be highlighted.
< � >< � > Set Math Channel desired (0A-0F) or type in channel.
0A < Enter >
< Tab > Mode will be highlighted.
< � >< � > Turn channel On or Off. If Off is selected, programming is

complete.
< Tab > Formula will be highlighted. To enter a math formula type the

expression. (maximum of 36 characters)
Ol.GT.02 < Enter >

To edit formula,
< � > Until cursor is under item to be changed, type desired change.
Change < Enter > To insert items into a math statement,
< � > Cursor is under the point you wish to insert,
< Insert > Item Type item to be inserted,
< Enter > You may also delete items from a math statement.
< � > To move the cursor to the desired item to be deleted.
< Delete > Item
< Enter > When complete.
< Tab > Decimal is highlighted.
< � >< � > Select from values 0-4.
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< Tab > Units will be highlighted. Set units. (maximum of 6 characters) (For
more information, refer to IM 4D5B1-01E, Table 7.3 Characters)

Tons < Enter >

Note: For further information on Math, see  IM 4D5B1-01E.

< Tab > Tag will be highlighted.
< Enter > User programmable value up to 7 characters.(For more information,

refer to IM 4D5B1-01E, Table 8.1 Characters)
< Tab > Printout will be highlighted.
< � >< � > Select On or Off.
< Tab > Alarm 1 will be highlighted
< � >< � > To turn Alarm Off or select from High or Low. If Off, setting is

complete.
< Tab > Setpoint 1 will be highlighted
50 < Enter > Select Set Point value.
< Tab > Relay 1 ID will be highlighted.

Note: Relay ID selections are dependent on the number of alarm output relays installed in the

recorder.

< � >< � > Turn relay Off or select from relays I01-I06. If Off, setting is
complete.

< Tab > Alarm 2 will be highlighted
(Repeat as above for Alarms 2 through 4).

< F10 > Return to Edit Menu.

Math Constants

< F4 > Math Constants. Constant 1 will be highlighted. There are
ten constants (01-10).
Enter value to be set.

1.234 < Enter >
< Tab > Constant 2 will be highlighted.

Repeat as above for constants 2-10.
When all Constants have been set:

< F10 > Return to Edit Menu.

Note: The Constant lE+29 cannot be set in this software. You must enter this Constant at the

recorder. For more information on setting Constants, refer to  IM 4D5B1-01E.
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End Edit

KEY STROKE EXPLANATION

< F10 > End Edit.
DO YOU WISH TO SAVE YOUR CHANGES?

< Fl > YES.
< F2 > NO.

Return to Main Menu.

Load Configuration to Recorder

From Main Menu

KEY STROKE EXPLANATION

< F6 > Load configuration to recorder.
< Enter > Instrument number.

Enter the file name you wish to load.
Test < Enter >

Note: When load starts, an error list will appear on the screen. Data loaded into the recorder

will be displayed in the lower left hand corner of the screen. This will take a few minutes.

Upon completion of "LOAD" the recorder display will be in MANUAL mode.

Caution: In order to load the configuration to the µR1000 Dot Model, the TLOG must be stopped.

If the TLOG isn't stopped the configuration will not be downloaded from the PC to the

recorder and an error will occur. You must stop the TLOG and repeat the Load

Configuration steps. Refer to "Start/Stop the TLOG computation" in IM 4D5B1-20E for

more information on the operation mode.

When complete,
< F10 > Prior Menu.
< F10 > Prior Menu.
< F10 > End Program.
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µR1800 Dot Model

Software Limitations

VARILINK™ 1.4 performs data acquisition for the µR1800 Dot Model strip chart recorder. Items
in the Setup Mode of the recorder cannot be set from VARILINK™ 1.4. Refer to Instruction
Manuals IM 4H3B1-01E and IM 4H3B1-10E for a detailed explanation of items in the Setup
Mode.

The clock in the recorder cannot be accessed or set through VARILINK™ 1.4.

The following items can be configured from VARILINK™ 1.4: Ranges, Alarms, Zones, Partial,
Print Format, Tags, Messages, Chart Speeds, Math Channels, Constants and Engineering Units.

Exceptions: 1)  The constant 1E + 29 may not be entered through this software.
2)  10Ω copper RTD inputs cannot be configured via VARILINK™.

Requirements

1. IBM or compatible computer;
2. DOS 2.1 or higher;
3. Johnson Yokogawa Corporation VARILINK™ 1.4 software;
4. Recorder with RS422A port:

a. Refer to  IM 4H3B1-01E
b. If computer is equipped with a RS232C port, a RS422A to RS232C converter is

required.

Recorder Setup

KEY STROKE EXPLANATION

< Enter > Power-up recorder while pressing < Enter > on the recorder panel.
Refer to Parameter Display and Contents for setting information.
SETUP is displayed, ALARM is flashing

< � > Until OPT= (option) is displayed and flashing
< Enter >

OPT= is displayed, COMM is flashing
< Enter >

ADDRESS= is displayed, 01 is flashing
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< � > Select a number (01-16). See note below.
< Enter >

BAUD RATE= is displayed
< � >< � > Select 9600
< Enter >

D. LEN= (data length) is displayed
< � >< � > Select 8 DATA BITS
< Enter >

PARITY= is displayed
< � >< � > Select NONE
< Enter >

STOP BIT is displayed
< � >< � > Select 1
< Enter >

*COMM SET* is displayed
< Enter >
< ESC > To return to setup display
< � >< � > Until END is displayed
< Enter >

END = STORE is displayed
< Enter > Settings are complete

Caution: Do not turn off power to the recorder while information is being stored. The recorder will

reboot automatically.

Note: Device #1 = Address 1, Device #2 = Address 2, etc.

Computer Setup

Boot up computer on DOS and install Johnson Yokogawa Corporation VARILINK™ 1.4 software in
your disk drive.

KEY STROKE EXPLANATION

VARILINK™ < Enter > After a moment, the MAIN MENU will appear as follows:
< Fl > Display & Data Acquisition Menu.
< F2 > Edit Configuration.
< F3 > Setup Computer.
< F4 > Save All Setup Parameters.
< F5 > Save Configuration From Recorder.
< F6 > Load Configuration to Recorder.
< F7 > HR2400 IC Card.
< F8 > HR2400 reports.
< F10 > End Program.

From Main Menu
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KEY STROKE EXPLANATION

< F3 > Setup Computer
< Enter >
< Fl > Setup Com Ports
< F2 > Select Devices
< F3 > Prior Menu

KEY STROKE EXPLANATION

< Fl > Setup Com Ports
< Enter >
< F1 > change Com Port 1
< F2 > change Com Port 2
< F3 > change Com Port 3
< F4 > change Com Port 4

Repeatedly pressing the appropriate function key will scroll the various Baud Rate choices.
(Minimum = 300, maximum = 9600). Select the appropriate rate.

Then press:

< F10 > Prior Menu.

From Setup Computer Menu

KEY STROKE EXPLANATION

< F2 > Select Devices.
Enter number of device to be edited:

< Enter > Select Devices Menu appears.
< F2 > Device Number:
< F3 > Device Type:
< F4 > Start Channel:
< F5 > End Channel:
< F6 > Interface:
< F7 > Address:
< F10 > Prior Menu

Note: For Data Display and Acquisition, device types are limited to only those devices which are

connected to the computer. Failure to do so will create a program error. A maximum of 144

devices may be selected. A maximum of 1200 input channels may be selected.
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KEY STROKE EXPLANATION

< F3 > Device type: press repeatedly until µR1800 appears.
< F4 > Start Channel:

Enter new starting channel: (sequential order, lowest
contiguous channel)

< Enter >
< F5 > Set End Channel:

Enter new ending Channel: (sequential order, highest
contiguous channel)

< Enter >

Note: < F4 > and < F5 > functions only pertain to data acquisition and data display of

information.

< F6 > Interface: press < F6 > repeatedly to select Com Port (this is the
Com Port on your computer to which you have connected the µR1800
dot model recorder, Com 1 through Com 4).

< F7 > Address: Press < F7 > repeatedly until you reach the address set
during the recorder setup procedure. (see note)

Note: The address setting must match the setting in the recorder. For more information, refer to

the recorder setup for the µR1800 Dot Model.

< F10 > 3 times Return to Main Menu. The computer is now Setup for
communications with the µR1800 dot model recorder.

< F4 > Save All Setup Parameters.

Display and Data Acquisition Menu

From Main Menu

KEY STROKE EXPLANATION

< Fl > Display & Data Acquisition.
Setup Data Acquisition Menu will appear.
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Setup Data Acquisition

< Fl > Help
< F2 > Sampling rate: (seconds)
< F3 > Filename to store data to: (your file name)
< F4 > File type:
< F5 > Number of rows in data file: (Samples per

channel)
< F6 > Number of columns in data file: (number of

channels)
< F8 > Save All Setup Parameters
< F9 > Start Main Program (start Display or Data

Acquisition)
< F10 > Prior Menu

Note: Spreadsheet software places a limitation on the number of columns that are available for

use in data acquisition. The limit is 250 columns or, as used in VARILINK™ 1.4, a total of

250 Channels. When the number of channels to be acquired exceeds 250, VARILINK™

1.4 will automatically write multiple files to disk to accommodate the excess over the 250

limit. See Example #1 below.

The ability to write multiple files simultaneously could also be used to segregate data as

desired. See example #2 below.

Example 1: Selected Devices 1 through 11 are µR1800 Dot models with 24 channels each
and 264 total points. All other devices are set NA.

Set number of columns in data file to 250 (max allowed), File name = TEST.
VARILINK™ 1.4 will save the data to 2 separate files.
File Name #1 will be TESTA00.WKl (Inputs 1-250).
File Name #2 will be TESTB00.WKl (Inputs 251-264).

Example 2: Selected devices 1, 2, 3, 4 and 5 are µR1800 Dot Models with 12 points each
and 60 total points. All other devices are set to NA.

Set Number of columns to 12, File name = DATUM.
VARILINK™ 1.4 will save the information to 5 separate files.
File Name #1 will be DATUMA00.WK1 (Recorder #1)
File Name #2 will be DATUMB00.WKl (Recorder #2)
File Name #3 will be DATUMC00.WKl (Recorder #3)
File Name #4 will be DATUMD00.WK1 (Recorder #4)
File Name #5 will be DATUME00.WK1 (Recorder #5)

Note: The maximum number of files that can be created is 14.



VARILINK ™
µR1800 Dot Model Recorders

IM VARILINK™ 1.4

© 1995  Yokogawa Corporation

3rd Edition, January 1995

20

Example 3: Selected Device #1 is a µR1800 Dot Model, 24 Channels. Channels 1 to 9 to
be saved in one file, Channels 10 to 18 to be saved in a different file. Data
samples every 30 seconds. Number of samples per point is 1000. File name is
TEST. All other Selected Devices are set to NA.

See the following data entries.

KEY STROKE EXPLANATION

< Fl > Help screen for Data Acquisition.
< F10 > To return to Main Menu.
< F2 > Sampling rate. This setting is in seconds: minimum setting is 2

seconds, maximum setting is 21,600 seconds or 6 hours. This setting
determines how often to save data from the recorder to the file.

30 < Enter >
< F3 > Filename to store data to: Enter complete path and your

own file name with a maximum of 5 characters.
Test < Enter >
< F4 > File type: you have 2 choices: .WKl (Lotus spreadsheet format)

or .DIF (Data interchange format). This is accomplished by pressing
< F4 > (each time you press < F4 > .WKl and .DIF will toggle on the
screen).

< F5 > Number of rows in data file: minimum 500, maximum
8,180. This is the number of samples of each acquired channel to be
stored in each file.

1800 < Enter > 1800 samples of each acquired channel will be taken before a new file
is created.

< F6 > Number of columns in data file: minimum 1 column,
maximum 250 columns. (Number of columns equals number of
channels.)

2 < Enter > File #1 name = TESTA00. WK1 (Channels 1 to 9)
File #2 name = TEST B00.WK1 (Channels 10 to 18)

< F8 > Save All Setup Parameters: this will save the settings < F2 >
through < F6 > to the default file for Data Acquisition.

< F9 > Start Main program. The computer screen will display
Testing Communications. Also, at the bottom left of the screen
you will observe data being read from the µR1800 dot model. After
approximately one minute, Main Data Menu will appear.

 Main Data Menu

< Fl > Display Data
< F2 > Data Acquisition
< F3 > HR2400 IC Card
< F10 > Main Menu
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Display Data

KEY STROKE EXPLANATION

< F1 > Display data.
 < � >< � > To scroll through channels, use these keys.
< Page Up >
< Page Down > Scrolls pages of channels.

Note: You may move directly to a given channel by typing that channel’s defined tag name.

< F10 > Return to Main Data Menu.

Data Acquisition

KEYSTROKE EXPLANATION

< F2 > Data Acquisition.
Start/Stop Data Acquisition Menu wil l appear. At this
point in the program, you may change any of the parameters < F2 >
through < F6 > described in the Data Acquisition Menu
section discussed earlier.

< Fl > or To start Data Acquisition.
< F10 > Return to Main Data Menu.

If < Fl > was selected
< F1 > Stop Data Acquisition when Data Acquisition is complete.

Note: The number of samples taken is displayed in the lower left portion of the screen. Also, the

current file is displayed to the right of samples taken. Once a file is full, the program will

create another file automatically. A maximum of 224 files will be created. However, if disk

space is depleted, program will stop.

File creation Example: File name = Test
Current File: Test?00 will appear; once this file is full, the current file:

Test?01 will appear.

Note: After Data Acquisition is complete, the Menu will return to Start/Stop Data
Acquisition. If < Fl > is pressed and the file name has not been changed, a box will

appear under < F10 > Prior Menu: Do you want to overwrite the
existing files (Y/N). If Y is selected, the current file will be overwritten.

KEY STROKE EXPLANATION

< F10 > Return to Main Menu.
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Edit Configuration

From Main Menu

Save Configuration from Recorder

Note: A configuration file must be in the default directory before "Edit Configuration" can begin.

KEY STROKE EXPLANATION

If you have a new disk or a disk that does not have an existing file:

Note: Configuration files are .PNL extension files.

< F5 > Save configuration from recorder.
< Enter > Select recorder to save data from.
Test< Enter > Enter file name to save configuration

to(without extension)

Note: VARILINK™ 1.4 will save data from all channels of the recorder to the default operating

directory.

Screen will flash WORKING. When Save Configuration is complete, program
will return to MAIN MENU. The recorder display will be left in "MANUAL"
mode.

Edit Configuration

From Main Menu

KEY STROKE EXPLANATION

< F2 > Edit Configuration

Edit Menu
Select Instrument to Edit

< F1 > HR2400
< F2 > HR2500
< F3 > µR1000/1800
< F10 > Prior Menu
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Temperature Units

KEY STROKE EXPLANATION

Select ºF or ºC.
< F1 > ºF.
< F2 > ºC.

Note: This selection does not change recorder setup for temperature. The change can only be

made in the Setup Mode of the recorder. If you do not have temperature inputs, select

< Fl > ºF.

Edit µR1800 Dot Model Configuration

Enter the file to be edited.

KEY STROKE EXPLANATION

Test < Enter > Checking Input File for errors will appear. If file is not
corrupted, Edit Menu will appear.

Note: If you have a file error, resave your file from recorder. (Refer to save configuration from

recorder.)

Edit Menu

Select item to be edited.

< Fl > Ranges, Tags, Units, Printout, Alarms, Zones
and Partials

< F2 > Chart Speeds, Print, Messages and Daylight
Savings Settings(optional)

< F3 > Math Channels, Tags, Units, Printout and Alarms
< F4 > Math Constants
< F10 > End Edit

For an explanation of items < Fl > and < F2 >, refer to  IM 4H3B1-01E. < F3 > and < F4 >, refer to
IM 4H3B1-20E.
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Ranges, Tags, Units, Printout, Alarms, Zones and Partials

KEY STROKE EXPLANATION

< Fl > Ranges, Tags, Units, Printout, Alarms, Zones
and Partials. Channel will be highlighted.

< � >< � > Select channel to be edited. Select from channels 1-24. (For example:
Stop on Channel 1.)

Note: The number of channels is dependent upon the model configuration you have selected. The

recorder could contain 6, 12, 18 or 24 channels.

< Tab > Mode will be highlighted.
< � > Change input type. (For example: Stop on Volt.)

The following items may be selected:

Volt Voltage ranges from 20mV to 50 volts DC
TC (Thermocouples) Select from R, S, B, K, E, J, T, L, U, N or W
RTD (Resistance thermal detectors) Select from Pt or JPt
Delta For measurement channels greater than #1
Scale Volt Voltage ranges from 20mV to 50 volts DC
Scale TC Select from R, S, B, K, E, J, T, L, U, N or W
Scale RTD (Resistance thermal detectors) Select from Pt or JPt
Square Root Voltage ranges from 20mV to 50 volts DC
DI (Digital Input) Level or Contact
Math (Math)
Skip (Channel off)

KEY STROKE EXPLANATION

< Tab > Range will be highlighted.
< � >< � > Change input type.
< Tab > Left Span will be highlighted. This is left span (0% value).
1 < Enter > Low end input value.
< Tab > Right Span (100% value).
5 < Enter > High end input value.
< Tab > Tag will be highlighted.

Type in Tag Name. (maximum of 7 characters) (For more information,
refer to IM 4H3B4-01E, Table 8.1 Characters)

FT-101 < Enter > After all characters have been entered

Note: If you choose to turn the scaling on, you will need to perform the next section. If scaling is

off, TAB will go to Alarm.

< Tab > Left Scale will be highlighted.
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0.0 < Enter > Left scale value.
< Tab > Right scale will be highlighted:
100.0 < Enter > Right scale value.
< Tab > Units will be highlighted. (maximum of 6 characters) (For more

information, refer to IM 4H3B4-01E, Table 7.3 Characters)
Tons < Enter >
< Tab > Alarm 1 will be highlighted
< � >< � > To turn Alarm Off or select H=High, L=Low, RH=Rate of change

high, RL=Rate of change low. If Off, setting is complete.
< Tab > Setpoint 1 will be highlighted
50 < Enter > Select Set Point value.
< Tab > Relay 1 ID will be highlighted.

Note: Relay choices range from I01-I24. The recorder must be equipped with /A1 (2 relays), /A2,

/A3 (4 relays), /A4 (6 relays) or /A5 (12 relays) for settings to be valid.

< � >< � > Turn relay Off or select from relays I01-I06. If Off is  selected,
setting is completed.

< Tab > Alarm 2 will be highlighted
(Repeat as above for Alarms 2 through 4).

< Tab > Left Zone will be highlighted. Set Value. (minimum)
0 < Enter >
< Tab > Right Zone will be highlighted. Set value. (maximum)
100 < Enter >

Note: The minimum width of a zone is 5mm. The maximum setting is 100mm. For more

information on Zones, refer to µR1800 Dot Model  IM 4H3B4-OlE.

< Tab > Partial will be highlighted.
< � >< � > Turn Partial On or Off.

If On is selected proceed as below. If off, setting is complete.
< Tab > Percent will be highlighted.

Set percentage.
25 < Enter >
< Tab > Boundry will be highlighted.

Set value.
10 < Enter >
< Tab > To edit other channels or,
< F10 > To return to µR1800 Dot Model Edit Configuration

Menu.

For more information on Partial, see µR1800 Dot Model  IM 4H3B4-OlE.
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Charts, Print, Messages and Daylight Savings Settings

 KEY STROKE EXPLANATION

< F2 > Chart Speed 1 will be highlighted.
< � >< � > Scroll to select chart speed.
25 < Enter > Set Chart Speed.
< Tab > Chart Speed 2 will be highlighted.

Set Chart Speed.
< Enter >

Note: This is the Chart Speed and Interval used when change on Alarm or Remote Control is in

effect. For further information, see  IM 4H3B1-01E.

< Tab > Print will be highlighted
< � >< � > Select auto or fix.
< Enter >
< Tab > Message 1 will be highlighted.
< Enter > Input message to be displayed. (For more information, refer to IM

4H3B4-01E, Table 8.2 Characters)
< Tab > Message 2 will be highlighted.

Repeat as above for messages 2-5.

Note: The daylight savings settings are only available if the recorder is equipped with the

daylight savings option. For more information on this selection, refer to IM 4H3B4-50E.

< Tab > Daylight Mode will be highlighted.
< � >< � > Select Winter or Summer Mode.
< Tab > Enter YY/MM/DD HH. Hours range from 00 to 23.
< Enter >

< F10 > Prior Menu.

 Math Channels, Tags, Units, Printout and Alarms

KEY STROKE EXPLANATION
< F3 > Math Channels, Tags, Units, Printout and

Alarms. Channel will be highlighted.
< � >< � > Set Math Channel desired (0A-0P) or type in channel. Letters H, I, L

and O are not valid selections.
< Tab > Mode will be highlighted.
< � >< � > Turn channel On or Off. Keep channel On. If Off is selected,

programming is complete .
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< Tab > Formula will be highlighted. To enter a math formula type the
expression. (maximum of 36 characters)

Ol.GT.02 < Enter >
To edit formula,

< � > Until cursor is under item to be changed, type desired change.
Change < Enter > To insert items into a math statement,
< � > Cursor is under the point you wish to insert,
< Insert > Item Type item to be inserted,
< Enter > You may also delete items from a math statement.
< � > To move the cursor to the desired item to be deleted.
< Delete > Item
< Enter > When complete.
< Tab > Decimal is highlighted.
< � >< � > Select from values 0-4.
< Tab > Units will be highlighted. Set units. (maximum of 6 characters)
Tons < Enter >

Note: For further information on Math, see  IM 4H3B1-01E.

< Tab > Tag will be highlighted.
< Enter > User programmable value up to 7 characters.
< Tab > Printout will be highlighted.
< � >< � > Select On or Off.
< Tab > Alarm 1 will be highlighted
< � >< � > To turn Alarm Off or select from High or Low. Make selection.

If Off, setting is complete.
< Tab > Setpoint 1 will be highlighted
50 < Enter > Select Set Point value.
< Tab > Relay 1 ID will be highlighted.

Note: Relay ID selections are dependent on the number of alarm output relays installed in the

recorder.

< � >< � > Turn relay Off or select from relays I01-I24. Recorder must be
equipped with /A1, /A2, /A3, /A4 or /A5 for settings to be valid. If
Off, setting is complete.

< Tab > Alarm 2 will be highlighted
(Repeat as above for Alarms 2 through 4).

< F10 > Return to Edit Menu.

Math Constants

< F4 > Math Constants. Constant 1 will be highlighted. There are
ten constants (01-10).
Enter value to be set.

1.234 < Enter >



VARILINK ™
µR1800 Dot Model Recorders

IM VARILINK™ 1.4

© 1995  Yokogawa Corporation

3rd Edition, January 1995

28

< Tab > Constant 2 will be highlighted.
Repeat as above for constants 2-10.
When all Constants have been set:

< F10 > Return to Edit Menu.

Note: The Constant lE+29 cannot be set in this software. You must enter this Constant at the

recorder. For more information on setting Constants, refer to  IM 4H3B4-20E.

End Edit

KEY STROKE EXPLANATION

< F10 > End Edit
DO YOU WISH TO SAVE YOUR CHANGES?

< F1 > YES
< F2 > NO

Return to Main Menu

Load Configuration to Recorder

From Main Menu

KEY STROKE EXPLANATION

< F6 > Load configuration to recorder.
< Enter > Instrument number.

Enter the file name you wish to load.
Test < Enter >

Note: When load starts, an error list will appear on the screen. Data loaded into the recorder will

be displayed in the lower left hand corner of the screen. This will take a few minutes. Upon

completion of "LOAD", the recorder display will be left in "MANUAL" mode.

Caution: In order to load the configuration to the µR1800 Dot Model, the TLOG must be stopped. If

the TLOG isn't stopped the configuration will not be downloaded from the PC to the

Recorder and an error will occur. You must stop the TLOG and repeat the Load

Configuration steps. Refer to "Start/Stop the TLOG Computation" in IM 4H3B1-20E for

more information on the operation mode.

When complete,
< F10 > Prior Menu.
< F10 > Prior Menu.
< F10 > End Program.
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µR1000/µR1800 Pen Model

Software Limitations

VARILINK™ 1.4 performs data acquisition for the µR1000/µR1800 Pen Model strip chart
recorders. Items in the Setup Mode of the recorder cannot be set from VARILINK™ 1.4. Refer to
Instruction Manuals IM 4D5B1-01E and IM 4D5B1-10E for a detailed explanation of items in the
Setup Mode.

The clock in the recorder cannot be accessed or set through VARILINK™ 1.4.

The following items can be configured from VARILINK™ 1.4: Ranges, Alarms, Zones, Partial,
Print Format, Tags, Messages, Chart Speeds, Match Channels, Constants and Engineering Units.

Exception: The constant 1E + 29 may not be entered through this software.

Requirements

1. IBM or compatible computer;
2. DOS 2.1 or higher;
3. Johnson Yokogawa Corporation VARILINK™ 1.4 software;
4. Recorder with RS422A:

a. Refer to  IM 4D5B1-01E for the µR1000 or IM 4H3B1-01E for the µR1800.
b. If computer is equipped with a RS232C port, a RS422A to RS232C converter is

required.

Recorder Setup

KEY STROKE EXPLANATION

< Enter > Power-up recorder while pressing < Enter > on the recorder panel.
Refer to Parameter Display and Contents for setting information.
SETUP is displayed, ALARM is flashing

< � > Until OPT= (option) is displayed and flashing
< Enter >

OPT= is displayed, COMM is flashing
< Enter >

ADDRESS= is displayed, 01 is flashing
< � > Select a number (01-16). See note below .
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< Enter >
BAUD RATE= is displayed

< � >< � > Select 9600
< Enter >

D. LEN= (data length) is displayed
< � >< � > Select 8 DATA BITS
< Enter >

PARITY= is displayed
< � >< � > Select NONE
< Enter >

STOP BIT= is displayed
< � >< � > Select 1
< Enter >

*COMM SET* is displayed
< Enter >
< ESC > To return to setup display
< � >< � > Until END is displayed
< Enter >

END = STORE is displayed
< Enter > Settings are complete

Caution: Do not turn off power to the recorder while information is being stored. The recorder will

reboot automatically.

Note: Device #1 = Address 1, Device #2 = Address 2, etc.

Computer Setup

Boot up computer on DOS and install Johnson Yokogawa Corporation VARILINK™ 1.4 software in
your disk drive.

KEY STROKE EXPLANATION

VARILINK™ < Enter > After a moment, the MAIN MENU will appear as follows:
< Fl > Display & Data Acquisition Menu.
< F2 > Edit Configuration.
< F3 > Setup Computer.
< F4 > Save All Setup Parameters.
< F5 > Save Configuration From Recorder.
< F6 > Load Configuration to Recorder.
< F7 > HR2400 IC Card.
< F8 > HR2400 reports.
< F10 > End Program.
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KEY STROKE EXPLANATION

From Main Menu

< F3 > Setup Computer
< Fl > Setup Com Ports
< F2 > Select Devices
< F10 > Prior Menu

KEY STROKE EXPLANATION

< Fl > Setup Com Ports
< F1 > change Com Port 1
< F2 > change Com Port 2
< F3 > change Com Port 3
< F4 > change Com Port 4

Repeatedly pressing the appropriate function key will scroll the various Baud Rate choices.
(Minimum = 300, maximum = 9600). Select the appropriate rate.

Then press:

< F10 > Prior Menu.

From Setup Computer  Menu

KEY STROKE EXPLANATION

< F2 > Select Devices.
Enter number of device to be edited:

< Enter > Select Devices  Menu appears.
< F2 > Device Number:
< F3 > Device Type:
< F4 > Start Channel:
< F5 > End Channel:
< F6 > Interface:
< F7 > Address:
< F10 > Prior Menu

Note: For Data Display and Acquisition, device types are limited to only those devices which are

connected to the computer. Failure to do so will create a program error. A maximum of 144

devices may be selected. A maximum of 1200 input channels may be selected.
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KEY STROKE EXPLANATION

< F3 > Device type : press repeatedly until µR1000/ µR1800 appears.
< F4 > Start Channel:

Enter new starting channel:  (sequential order , lowest
contiguous channel)

< Enter >
< F5 > Set End Channel

Enter new ending Channel:  (sequential order , highest
contiguous channel)

< Enter >

Note: < F4 > and < F5 > functions only pertain to data acquisition and data display of

information.

< F6 > Interface : press < F6 > repeatedly to select Com Port (this is the
Com Port on your computer to which you have connected the µR1000/
µR1800 pen model recorder, Com 1 through Com 4).

< F7 > Address:  Press < F7 > repeatedly until you reach the address set
during the recorder setup procedure. (see note)

Note: The address setting must match the setting in the recorder. For more information, refer to

the recorder setup for the µR1000/ µR1800 Pen Model.

< F10 > 3 times Return to Main Menu . The computer is now Setup for
communications with the µR1000/µR1800 pen model recorder.

< F4 > Save All Setup Parameters.

Display and Data Acquisition Menu

From Main Menu

KEY STROKE EXPLANATION

< Fl > Display & Data Acquisition.
Setup Data Acquisition  Menu will appear .
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Setup Data Acquisition

< Fl > Help
< F2 > Sampling rate:  (seconds)
< F3 > Filename to store data to:  (your file name)
< F4 > File type:
< F5 > Number of rows in data file:  (Samples per

channel)
< F6 > Number of columns in data file:  (number of

channels)
< F8 > Save All Setup Parameters
< F9 > Start Main Program  (start Display or Data

Acquisition)
< F10 > Prior Menu

Note: Spreadsheet software places a limitation on the number of columns that are available for

use in data acquisition. The limit is 250 columns or, as used in VARILINK™ 1.4, a total of

250 Channels. When the number of channels to be acquired exceeds 250, VARILINK™

1.4 will automatically write multiple files to disk to accommodate the excess over the 250

limit. See Example #1 below.

The ability to write multiple files simultaneously could also be used to segregate data as

desired. See example #2 below.

Example 1: Selected Devices 1 through 64 are µR1000/µR1800 Pen models with 4
channels each and 256 Total points. All other Devices are set NA.

Set number of columns in data file to 250 (max allowed), File name = TEST.
VARILINK™ 1.4 will save the data to 2 separate files.
File Name #1 will be TESTA00.WKl (Inputs 1-250).
File Name #2 will be TESTB00.WKl (Inputs 251-254).

Example 2: Selected devices 1, 2, 3, 4 and 5 are µR1000/µR1800 Pen Models with 4
points each and 20 points total. All other devices are set to NA.

Set Number of columns to 4, File name = DATUM.
VARILINK™ 1.4 will save the information to 5 separate files.
File Name #1 will be DATUMA00.WK1 (Recorder #1)
File Name #2 will be DATUMB00.WKl (Recorder #2)
File Name #3 will be DATUMC00.WKl (Recorder #3)
File Name #4 will be DATUMD00.WK1 (Recorder #4)
File Name #5 will be DATUME00.WK1 (Recorder #5)

Note: The maximum number of files that can be created is 14.
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Example 3: Selected Device #1 is a µR1000/µR1800 Pen Model with 4 Channels.
Channels 1 & 2 to be saved in one file, Channels 3 & 4 to be saved in a
different file. Data samples every 30 seconds. Number of samples per point is
1000. File name is TEST. All other Selected Devices are set to NA.

See the following data entries.

KEY STROKE EXPLANATION

< Fl > Help screen for Data Acquisition.
< F10 > To return to Main Menu .
< F2 > Sampling rate . This setting is in seconds: minimum setting is 2

seconds, maximum setting is 21,600 seconds or 6 hours. This setting
determines how often to save data from the recorder to the file.

30 < Enter >
< F3 > Filename to store data to:  Enter complete path and your

own file name with a maximum of 5 characters.
Test < Enter >
< F4 > File type : you have 2 choices: .WKl  (Lotus spreadsheet format)

or .DIF  (Data interchange format). This is accomplished by pressing
< F4 > (each time you press < F4 > .WKl  and .DIF  will toggle on the
screen).

< F5 > Number of rows in data file : minimum 500, maximum
8,180. This is the number of samples of each acquired channel to be
stored in each file.

1800 < Enter > 1800 samples of each acquired channel will be taken before a new file
is created.

< F6 > Number of columns in data file : minimum 1 column,
maximum 250 columns. Number of columns equals number of
channels. (see note)

2 < Enter > File #1 name = TESTA00. WK1 (Channels 1-2)

File #2 name = TEST B00.WK1 (Channels 3-4)
< F8 > Save All Setup Parameters : this will save the settings < F2 >

through < F6 > to the default file for Data Acquisition.
< F9 > Start Main program . The computer screen will display

Testing Communications . Also, at the bottom left of the screen
you will observe data being read from the µR1000/µR1800 pen model.
After approximately one minute, Main Data Menu  will appear.

 Main Data Menu

< Fl > Display Data
< F2 > Data Acquisition
< F3 > HR2400 IC Card
< F10 > Main Menu



VARILINK ™
µR1000/µR1800 Pen Model Recorders

IM VARILINK™ 1.4

© 1995 Yokogawa Corporation

3rd Edition, January 1995

35

Display Data

KEY STROKE EXPLANATION

< F1 > Display data.
 < � >< � > To scroll through channels, use these keys.
< Page Up >
< Page Down > Scrolls pages of channels.

Note: You may move directly to a given channel by typing that channel’s defined tag name.

< F10 > Return to Main Data Menu .

Data Acquisition

KEYSTROKE EXPLANATION

< F2 > Data Acquisition.
Start/Stop Data Acquisition  Menu will appear. At this
point in the program, you may change any of the parameters < F2 >
through < F6 > described in the Data Acquisition Menu
section discussed earlier.

< Fl > or To start Data Acquisition.
< F10 > Return to Main Data Menu .

If < Fl > was selected
< F1 > Stop Data Acquisition when Data Acquisition is complete.

Note: The number of samples taken is displayed in the lower left portion of the screen. Also, the

current file is displayed to the right of samples taken. Once a file is full, the program will

create another file automatically. A maximum of 224 files will be created. However, if disk

space is depleted, program will stop.

File creation Example: File name = Test
Current File: Test?00  will appear; once this file is full, the current file:

Test?01  will appear.

Note: After Data Acquisition is complete, the Menu will return to Start/Stop Data
Acquisition. If < Fl > is pressed and the file name has not been changed, a box will

appear under < F10 > Prior Menu: Do you want to overwrite the
existing files (Y/N). If Y is selected, the current file will be overwritten.

KEY STROKE EXPLANATION

< F10 > Return to Main Menu .
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Edit Configuration

From Main Menu

Save Configuration from Recorder

Note: A configuration file must be in the default directory before "Edit Configuration" can begin.

KEY STROKE EXPLANATION

If you have a new disk or a disk that does not have an existing file:

Note: Configuration files are .PNL extension files.

< F5 > Save configuration from recorder.
< Enter > Enter instrument number:
Test< Enter > Enter f ile name to save configuration

to:(without extension)

Note: VARILINK™ 1.4 will save data from all channels of the recorder to the default operating

directory.

Screen will flash WORKING. When Save Configuration is complete, program
will return to MAIN MENU. The recorder display will be left in "MANUAL"
mode.

Edit Configuration

From Main Menu

KEY STROKE EXPLANATION

< F2 > Edit Configuration
Edit Menu

Select Instrument to Edit
< Enter >
< F1 > HR2400
< F2 > HR2500
< F3 > µR1000/1800
< F10 > Prior Menu
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Temperature Units

KEY STROKE EXPLANATION

Select ºF or ºC.
< F1 > ºF.
< F2 > ºC.

Note: This selection does not change recorder setup for temperature. The change can only be

made in the Setup Mode of the recorder. If you do not have temperature inputs, select

< Fl > ºF.

Edit µR1000/µR1800 Pen Model Configuration

Enter the file to be edited.

KEY STROKE EXPLANATION

Test < Enter > Checking Input File for errors will appear. If file is not
corrupted, Edit Menu  will appear.

Note: If you have a file error, resave your file from recorder. (Refer to save configuration from

recorder.)

Edit Menu

Select item to be edited.

< Fl > Ranges, Tags, Units, Printout, Alarms, Zones
and Partials

< F2 > Chart Speeds, Print, Messages and Daylight
Savings Settings (optional)

< F3 > Math Channels, Tags, Units, Printout and Alarms
< F4 > Math Constants
< F10 > End Edit

For an explanation of items < Fl > and < F2 >, refer to IM 4D5B1-01E for µR1000 information and
IM 4H3B1-01E for the µR1800. < F3 > and < F4 >, refer to IM 4D5B1-20E for µR1000 and IM
4H3B1-20E for the µR1800.
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Ranges, Tags, Units, Printout, Alarms, Zones and Partials

KEY STROKE EXPLANATION

< Fl > Ranges, Tags, Units, Printout, Alarms, Zones
and Partials.  Channel will be highlighted.

< � >< � > Select channel to be edited. Select from channels 1, 2, 3 or 4. (For
example: Stop on Channel 1.)

< Tab > Mode will be highlighted.
< � > Change input type. (For example: Stop on Volt .)

The following items may be selected:

Volt Voltage ranges from 20mV to 50 volts DC
TC (Thermocouples) Select from R, S, B, K, E, J, T, L, U, N or W
RTD (Resistance thermal detectors) Select from Pt or JPt
Delta For measurement channels greater than #1
Scale Volt Voltage ranges from 20mV to 50 volts DC
Scale TC Select from R, S, B, K, E, J, T, L, U, N or W
Scale RTD (Resistance thermal detectors) Select from Pt or JPt
Square Root Voltage ranges from 20mV to 50 volts DC
DI (Digital Input) Level or Contact
Math (Math)
Skip (Channel off)

KEY STROKE EXPLANATION

< Tab > Range will be highlighted.
< � >< � > Change input type for TC, RTD, DI or range value for volts.
< Tab > Left Span will be highlighted. This is left span (0% value).
1 < Enter > Low end input value.
< Tab > Right Span  (100% value).
5 < Enter > High end input value.
< Tab > Tag will be highlighted.

Type in Tag Name. (maximum of 7 characters) (For more information,
refer to IM 4D5B1-01E or IM 4H3B1-01E, Table 8.1 Characters)

FT-101 < Enter > After all characters have been entered

Note: If you choose to turn the scaling on, you will need to perform the next section. If scaling is

off, TAB will go to Alarm.

< Tab > Left Scale will be highlighted.
0.0 < Enter > Left scale value.
< Tab > Right scale will be highlighted.
100.0 < Enter > Right scale value.
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< Tab > Units will be highlighted. (maximum of 6 characters) (For more
information, refer to IM 4D5B1-01E or IM 4H3B1-01E, Table 7.3
Characters)

Tons < Enter >
< Tab > Alarm 1 will be highlighted
< � >< � > To turn Alarm Off  or select H=High, L =Low, RH =Rate of change

high, RL =Rate of change low. If Off , setting is complete.
< Tab > Setpoint 1  will be highlighted
50 < Enter > Select Set Point value.
< Tab > Relay 1 ID will be highlighted.

Note: Although choices range from I01-I12, the relay selection for the µR1000/ µR1800 Pen

Model is limited to I01-I06. The recorder must be equipped with /A1, /A2  or /A3 for

settings to be valid.

< � >< � > Turn relay Off or select from relays I01-I06 . If Off  is sel ected,
setting is completed.

< Tab > Alarm 2  will be highlighted
(Repeat as above for Alarms 2 through 4).

< Tab > Left Zone  will be highlighted. Set Value. (minimum)
0 < Enter >
< Tab > Right Zone  will be highlighted. Set value. (maximum)
100 < Enter >

Note: The minimum width of a zone is 5mm. The maximum setting is 100mm. For more

information on Zones, refer to IM 4H3B4-OlE for the µR1000/ µR1800 Pen Model.

< Tab > Partial will be highlighted.
< � >< � > Turn Partial On or Off .

If On is selected proceed as below. If Off , setting is complete.
< Tab > Percent will be highlighted.

Set percentage.
25 < Enter >
< Tab > Boundry will be highlighted.

Set value.
10 < Enter >
< Tab > To edit other channels or,
< F10 > To return to µR1000/ µR1800 Pen Model Edit

Configuration Menu.

For more information on Partial, see µR1000/µR1800 Pen Model  IM 4H3B4-OlE.



VARILINK ™
µR1000/µR1800 Pen Model Recorders

IM VARILINK™ 1.4

© 1995 Yokogawa Corporation

3rd Edition, January 1995

40

Charts, Print, Messages and Daylight Savings Settings

 KEY STROKE EXPLANATION

< F2 > Chart Speed 1  will be highlighted.
< � >< � > Scroll to select chart speed.
25 < Enter > Set Chart Speed.
< Tab > Chart Speed 2 will be highlighted. (see note)

Set Chart Speed.
< Enter >

Note: This is the Chart Speed and Interval used when change on Alarm or Remote Control is in

effect. For further information, see IM 4D5B1-01E for µR1000 or IM 4H3B1-01E for

µR1800.

< Tab > Print will be highlighted
< � >< � > Select auto or fix.
< Enter >
< Tab > Message 1 will be highlighted.
< Enter > Input message to be displayed. (For more information, refer to IM

4D5B1-01E or IM 4H3B1-01E, Table 8.2 Characters)
< Tab > Message 2  will be highlighted.

Repeat as above for messages 2-5.

Note: The daylight savings settings are only available if the recorder is equipped with the

daylight savings option. For more information on this selection, refer to IM 4H3B4-50E.

< Tab > Daylight Mode  will be highlighted.
< � >< � > Select Winter or Summer Mode.
< Tab > Enter YY/MM/DD HH . Hours range from 00 to 23.
< Enter >

< F10 > Prior Menu.

 Math Channels, Tags, Units, Printout and Alarms

KEY STROKE EXPLANATION
< F3 > Math Channels, Tags, Units, Printout and

Alarms. Channel will be highlighted.
< � >< � > Set Math Channel desired (0A-0P) or type in channel. Letters H, I, L

and O are not valid selections.
0A  < Enter >
< Tab > Mode will be highlighted.
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< � >< � > Turn channel On or Off.  If Off is selected, programming is
complete.

< Tab > Formula will be highlighted. To enter a math formula type the
expression. (maximum of 36 characters)

Ol.GT.02 < Enter >
To edit formula,

< � > Until cursor is under item to be changed, type desired change.
Change < Enter > To insert items into a math statement,
< � > Cursor is under the point you wish to insert,
< Insert > Item Type item to be inserted,
< Enter > You may also delete items from a math statement.
< � > To move the cursor to the desired item to be deleted.
< Delete > Item
< Enter > When complete
< Tab > Decimal  is highlighted
< � >< � > Select from values 0-4
< Tab > Units will be highlighted. Set units (maximum of 6 characters) (For

more information, refer to IM 4D5B1-01E or IM 4H3B1-01E, Table
7.3 Characters)

Tons < Enter >

Note: For further information on Math, see  IM 4D5B1-20E for µR1000 or IM 4H3B1-20E for

µR1800.

< Tab > Tag will be highlighted
< Enter > User programmable value up to 7 characters (For more information,

refer to IM 4D5B1-01E or IM 4H3B1-01E, Table 8.1 Characters)
< Tab > Printout will be highlighted
< � >< � > Select On or Off
< Tab > Alarm 1 will be highlighted
< � >< � > To turn Alarm Off or select from High or Low.  Make selection.

If Off , setting is complete
< Tab > Setpoint 1  will be highlighted
50 < Enter > Select Set Point value
< Tab > Relay 1 ID will be highlighted

Note: Relay ID selections are dependent on the number of alarm output relays installed in the

recorder.

< � >< � > Turn relay Off or select from relays I01-I06 . If Off  is selected,
setting is complete.

< Tab > Alarm 2  will be highlighted
(Repeat as above for Alarms 2 through 4).

< F10 > Return to Edit Menu.
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Math Constants

< F4 > Math Constants. Constant 1  will be highlighted. There are
ten constants (01-10).
Enter value to be set.

1.234 < Enter >
< Tab > Constant 2 will be highlighted.

Repeat as above for constants 2-10.
When all Constants have been set:

< F10 > Return to Edit Menu.

Note: The Constant lE+29 cannot be set in this software. You must enter this Constant at the

recorder. For more information on setting Constants, refer to IM 4D5B1-20E for the

µR1000 or IM 4H3B4-20E for the µR1800..

End Edit

KEY STROKE EXPLANATION

< F10 > End Edit.
DO YOU WISH TO SAVE YOUR CHANGES?

< FL > YES.
< F2 > NO.

Return to Main Menu.

Load Configuration to Recorder

From Main Menu

KEY STROKE EXPLANATION

< F6 > Load configuration to recorder.
< Enter > Instrument number.

Enter the file name you wish to load.
Test < Enter >

Note: When load starts, an error list will appear on the screen. Data loaded into the recorder will

be displayed in the lower left hand corner of the screen. This will take a few minutes. Upon

completion of " LOAD", the recorder will be left in " MANUAL" mode.
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Caution: In order to load the configuration to the µR1000/ µR1800 Pen Model, the TLOG must be

stopped. If the TLOG isn't stopped the configuration will not be downloaded from the PC

to the Recorder and an error will occur. You must stop the TLOG and repeat the Load

Configuration steps. Refer to "Start/Stop the TLOG Computation" in IM 4D5B1-20E for

more information on the operation mode of the µR1000 or IM 4H3B1-20E for the µR1800.

When complete,
< F10 > Prior Menu.
< F10 > Prior Menu.
< F10 > End Program.
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HR2400

Software Limitations

Items in the Setup Mode of the recorder cannot be set from VARILINK™ 1.4. Refer to Instruction
Manuals IM 3760-OlE, IM 3760-70E, IM 3760-50E or IM 4082-S34E for a detailed explanation of
items in the Setup Mode.

The clock in the recorder cannot be accessed or set through VARILINK™ 1.4.

The following items can be configured from VARILINK™ 1.4: Ranges, Alarms, Interpolations,
Zones, Partial, Print Format, Tags, Messages, Headers, Title, Chart Speeds, Intervals, System
(Logging or Trend Format, Alarm Print, Recording mode), Moving Average, User Linearization,
RRJC, Math Channels and Constants.

Exception: The constant lE+29 may not be entered through this software.

Requirements

1. IBM or compatible computer;
2. DOS 2.1 or higher;
3. Johnson Yokogawa Corporation VARILINK™ 1.4 Software;
4. For recorder with RS232C;

a. Null Modem cable.
b. RS232C port on computer.

5. For recorder with RS422A;
a. Refer to  IM 4082S-34E.
b. If computer is equipped a RS232C port, a RS422A to RS232C converter is required.

Recorder Setup

The HR2400 recorder must be set to the following parameters in the Setup Mode. The Setup Mode
can be accessed by setting dip switch #l to the On position (dip switch is located behind chart
cassette). Next, cycle the power to the recorder and press the upper display key. After 10 seconds,
SETUP MODE = RECORD should appear in upper display.
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RS232C

KEY STROKE EXPLANATION UPPER DISPLAY
< Next > Located at bottom left side of recorder display . SETUP MODE = RECORD
< F3 > COMM SETUP MODE = COMM-SET
< Entry > 3 times 232C MODE =
< Fl > S & O (set and out) 232C MODE = SET & OUT
< Entry > Baud Rate BAUD RATE=
< Next >
< F4 > 9600. BAUD RATE = 9600
< Entry > DATA DATA =
< F2 > 8 bit DATA = 8 BIT
< Entry > PARITY PARITY =
< F3 > None PARITY = NONE
< Entry > STOP BIT STOP BIT =
< Fl > 1 STOP BIT = 1
< Entry > HANDSHAKE HANDSHAKE =
< F3 > X:R (XON:RS) HANDSHAKE = XON:RS
< Entry > Setup confirmed ***COMM-SET***
< Entry > Setup complete SETUP MODE = COMM SET
< F4 > End SETUP MODE = END
< Entry > Exit Setup Mode "CHANNEL DISPLAY"

The HR2400 is now setup to communicate with the computer.

Connect null modem cable between recorder and computer.

RS422A

KEY STROKE EXPLANATION UPPER DISPLAY

< Next > Located at bottom left side of recorder display. SETUP MODE = RECORD
< F3 > COMM SETUP MODE = COMM-SET
< Entry > 2 times, display will read address = ADDRESS =
< 1 > Set address 1 to 15 ADDRESS = "SELECTION"
< Entry > Display will read 232C mode 232C MODE =
< Fl > S & O (set and out) 232C MODE = SET & OUT
< Entry > Baud Rate BAUD RATE =
< Next >
< F4 > 9600. BAUD RATE = 9600
< Entry > DATA DATA =
< F2 > 8 bit DATA = 8 BIT
< Entry > PARITY PARITY =
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KEY STROKE EXPLANATION UPPER DISPLAY

< F3 > None PARITY = NONE
< Entry > STOP BIT STOP BIT =
< Fl > 1 STOP BIT = 1
< Entry > HANDSHAKE HANDSHAKE =
< Fl > Off HANDSHAKE = OFF;OFF
< Entry > 2 times; SETUP MODE ***COMM-SET***
< Entry > Setup confirmed SETUP MODE = COMM-SET
< F4 > Setup complete SETUP MODE = END
< Entry > End "CHANNEL DISPLAY"
< Entry > Exit to setup mode

The HR2400 is now setup to communicate with the computer.

Connect the appropriate cables between recorder and computer.

Computer Setup

Boot up computer on DOS and install Johnson Yokogawa Corporation VARILINK™ software in
your disk drive.

KEY STROKE EXPLANATION

VARILINK™ < Enter >After a moment, the Main Menu will appear as follows:
< F1 > Display & Data Acquisition Menu.
< F2 > Edit Configuration.
< F3 > Setup Computer.
< F4 > Save All Setup Parameters.
< F5 > Save Configuration From Recorder.
< F6 > Load Configuration to Recorder.
< F7 > HR2400 IC Card.
< F8 > HR2400 Reports.
< F10 > End Program.

KEY STROKE EXPLANATION

From Main Menu

< F3 > Setup Computer.
Set Up Computers

< Fl > Setup Com Ports.
< F2 > Select Devices.
< F10 > Prior Menu.
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KEY STROKE EXPLANATION

< Fl > change Com Port 1 baud rate.
< F2 > change Com Port 2 baud rate.
< F3 > change Com Port 3 baud rate.
< F4 > change Com Port 4 baud rate.

Repeatedly pressing the appropriate function key will scroll the various Baud Rate choices.
(Minimum = 300, maximum = 9600). Select the appropriate rate.

Then, press:

< F10 > Prior Menu.

KEY STROKE EXPLANATION

From Setup Computer Menu

< F2 > Select Devices.
Configured Devices

Enter number of device to be edited:
1< Enter > Device Number: Enter number of devices to be edited.
< F3 > Device Type:
< F4 > Start Channel:
< F5 > End Channel:
< F6 > Interface:
< F7 > Address: (for RS422C & GPIB only)
< F10 > Prior Menu

Note: For Data Display and Acquisition, device types are limited to only those devices which are

connected to the computer. Failure to do so will stop the program! A maximum of 144

devices may be set. A maximum of 1,200 channels may be selected.

< F3 > Device type: Press repeatedly until HR2400 appears
< F4 > Start Channel:
01< Enter > Enter new starting channel: (sequential order , lowest

contiguous channel)
< F5 > End Channel:
40< Enter > Enter new ending channel: (sequential order , highest

contiguous channel)
< F6 > Interface; press repeatedly to select your Com Port for RS232C

or RS422A (this is the Com Port on your computer to which you
have connected the HR2400, Com 1 through Com 4).
If your recorder has RS422A communications,

< F7 > Address: repeatedly press F7 until you reach the address set
during the recorder setup procedure.
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Note: If you do not want to save all channels for Data Acquisition/Display, you will have to setup

more than one device. Example: You have an HR2400 to work with 30 input channels and

the math option (channels 31-60). You only want to acquire data from channels 01-12 and

31-40 (channels 13-30 are skipped and math channels 41-60 are off). You must setup the

following:

< F2 > Device Number
Select Devices

1< Enter >
< F3 > Device type: Repeat until HR2400 appears.
< F4 > Start Channel: First channel to be saved.
01< Enter >
< F5 > End Channel: Last channel to be saved.
12< Enter >
< F2 > Device number:
2< Enter >
< F3 > Device type: Repeat until HR2400 appears.
< F4 > Start channel:
31< Enter >
< F5 > End channel:
40< Enter >
< F10 > 3 times Return to Main Menu. The computer is now setup for

communications with the HR2400.
< F4 > Save All Setup Parameters.

Display and Data Acquisition Menu

From the Main Menu,

KEY STROKE EXPLANATION

< Fl > Display and Data Acquisition Menu.
Setup Data Acquisition Menu will appear.

Setup Data Acquisition

The menu will appear as follows:

< Fl > Help
< F2 > Sampling rate: (seconds)
< F3 > Filename to store data to: (your file name)
< F4 > File type:
< F5 > Number of rows in data file: (samples per channel)
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< F6 > Number of columns in data file: (number of channels)
< F8 > Save All Setup parameters
< F9 > Start Main Program (start Display or Data Acquisition)
< F10 > Prior Menu

Note: Spreadsheet software places a limitation on the number of columns that are available for

use in data acquisition. The limit is 250 columns or, as used in VARILINK™ 1.4, a total of

250 channels. When the number to be acquired exceeds 250, VARILINK™ 1.4 will

automatically write multiple files to disk to accommodate the excess over the 250 limit. See

Example #1 Below.

The ability to write multiple files simultaneously could also be used to segregate data as

desired. See example #2 below.

Example 1: Selected devices 1 through 5 are HR2400 recorders with 30 channels
each, Math and 300 total points. All other devices are set to NA.

Set number of columns to 250 (max allowed), File Name = TEST
VARILINK™ 1.4 will save information to 2 files.
File Name #1 will be TESTA00.WK1 (Channels 1-250)
File Name #2 will be TESTB00.WK1 (Channels 251-300)

Example 2: (HR2400 with 30 channels saved to disk)

Set number of columns to 10, File Name = Test.
VARILINK™ 1.4 will save information to 3 files.
File Name #1 will be TESTA00.WKl (Channels 01-10)
File Name #2 will be TESTB00.WKl (Channels 11-20)
File Name #3 will be TESTC00.WKl (Channels 21-30)

Example 3: Selected Device #1 is an HR2400 with 30 channels each and math.
Channels 1 to 30 to be saved in one file, Channels 31 to 60 to be
saved in a different file. Data samples every 2 seconds. Number of
samples per point is 1000. File name is TEST. All other devices are
set to NA.

See the following data entries.

Note: The maximum number of files that can be created is 14.

KEY STROKE EXPLANATION

< Fl > Help screen for Data Acquisition.
< F10 > To return to Main Menu.
< F2 > Sampling rate; this setting is in seconds: minimum setting is 2

seconds, maximum setting is 21,600 seconds (6 hours). This setting
determines how often data is saved from the recorder to the file.

2 < Enter >
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< F3 > Filename to store data to: Enter complete path and
create your own file name with a maximum of 5 characters.

Test < Enter >
< F4 > File type: you have 2 choices: .WK1 (Lotus spreadsheet format)

or .DIF (Data interchange format). This is accomplished by
pressing < F4 > (each time you press < F4 > .WK1 and .DIF will
toggle on the screen).

< F5 > Number of rows in data file: minimum 500, maximum
8,180. This is the number of samples of each acquired channel to be
stored in each file.

1000 < Enter > 1000 samples of each acquired channel will be taken before a new
file is created.

< F6 > Number of columns in data file: minimum 1 column,
maximum 250 columns. This is the number of channels you wish to
save to a file.

< F8 > Save All Setup Parameters: this will save the settings
from < F2 > through < F6 > to the default file for Data Acquisition.

< F9 > Start Main Program: the computer screen will display
Testing Communications and Reading HR2400. Also
at the bottom left of the screen, you will observe data being read
from the HR2400, after approximately one minute, Main Data
Menu will appear.

 Main Data Menu

< Fl > Display Data
< F2 > Data Acquisition
< F3 > HR2400 IC Card
< F10 > Main Menu

 Display Data

KEY STROKE EXPLANATION

< Fl > Display data.
< � >< � > To scroll through channels, use these keys.
< Page Up > Scrolls pages of channels. (Or you may type Tag Name/Number of
< Page Down > the channel you wish displayed.)
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Example: You would like to display channel 20:

KEY STROKE EXPLANATION

lHR24 20 < Enter > Selected channel is moved to top of display.

< F10 > Return to Main Data Menu.

Data Acquisition

KEY STROKE EXPLANATION

< F2 > Data Acquisition.
Start/Stop Data Acquisition Menu will appear. At this
point in the program you may change any of the parameters < F2 >
through < F6 > described in the Data Acquisition Menu
section discussed earlier.

< Fl > or To start Data Acquisition.
< F10 > Prior Menu.
< Fl > was selected
< Fl > Stop Data Acquisition when Data Acquisition is complete.

Note: The number of samples taken is displayed in the lower left portion of the screen. Also, the

current file is displayed to the right of samples taken. Once a file is full, the program will

create another file automatically. A maximum of 224 files will be created. However, if disk

space is depleted, program will stop.

File creation Example: File name = Test
Current File: Test?00 will appear, once this file is full, the current file: Test?01

will appear.

Note:  After Data Acquisition is complete, the Menu will return to Start/Stop Data
Acquisition. If < Fl > is pressed and the file name has not been changed, a box will

appear under < F10 > Prior Menu: Do you want to overwrite the
existing files (Y/N). If Y is selected, the current file will be overwritten.

KEY STROKE EXPLANATION

< F10 > 2 times to return to Main Menu.
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HR2400 IC Card Measurement Data Retrieval

Setup the computer as described in the “Computer Setup” section of this chapter. Install HR2400 IC
Memory Card in the recorder.

From the Main Menu

KEY STROKE EXPLANATION

< F7 > HR2400 IC Card. Enter Instrument number:
1 < Enter >

HR2400 IC Card Menu will appea r:
< Fl > IC CARD DIRECTORY.
< F2 > SAVE DATA FROM IC CARD.
< F10 > PRIOR MENU.

, KEY STROKE EXPLANATION

< F1 > IC Card Directory; this directory will show all measurement
data file names on the HR2400 memory card.

< F10 > Prior Menu.
< F2 > Save data from IC Card.

Type file name to be saved from IC Card.
Test < Enter > The screen will flash WORKING, and an integer count begins. These

numbers represent the samples being saved from the IC memory card
to the disk. When complete, the program will return to the HR2400
IC Card Menu. If you have finished saving data files from the IC
memory card:

< F10 > 2 times The program will return to the Main Menu.

Note: When using RS422 communications on older “XT” type computers, you must set baud rate

at 4800 or below in order to retrieve data.

HR2400 Report Retrieval

The HR2400 recorder must have the report option. Setup the computer as described in the
“Computer Setup” section of this chapter.

From the Main Menu,

KEY STROKE EXPLANATION
< F8 > HR2400 reports.

Enter instrument number.
l < Enter >
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The screen will display the following Menu:

< Fl > Hourly Report
< F2 > Daily Report
< F3 > Monthly Report
< F10 > Prior Menu

Select the report from the above list that you wish to save. Type the file name to which you wish to
save the report.

KEY STROKE EXPLANATION

< Fl > Hourly report, enter file name for report.
Hour < Enter > Screen will display Saving report to disk. When report

has been saved to the file, the screen will return to the above Menu.
< F10 > Prior Menu

Note: For daily reports, you may only retrieve data within 1 hour of report printout. For monthly

reports, you may only retrieve data within 1 day of report printout.

Report must be “On” in the Setup Mode of the recorder in order to retrieve the reports from the
HR2400. For more information, refer to IM 3760-70E.

Edit Configuration

From Main Menu

Save Configuration from Recorder

Note: A configuration file must be in the default directory before "Edit Configuration" can begin.

If you have a new disk or a disk that does not have an existing file:

KEY STROKE EXPLANATION

< F5 > Save Configuration From Recorder.
1 < Enter > Enter instrument number:
Test< Enter > Enter File name to save configuration to (without

extension)

Note: VARILINK™ 1.4 will save all channels from the recorder.

Screen will flash WORKING when Save configuration is complete. Program will
return to Main Menu.
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Edit Configuration

From Main Menu

KEY STROKE EXPLANATION

< F2 > Edit Configuration
Edit Menu

Select instrument to edit
< Fl > HR2400
< F2 > HR2500
< F3 > µR1000/1800
< F10 > Prior Menu

Temperature Units

KEY STROKE EXPLANATION

Select ºF or ºC.
< F1 > ºF.
< F2 > ºC.

Note: This selection does not change recorder setup for temperature. The change can only be

made in the Setup Mode of the recorder. If you do not have temperature inputs, select

< Fl > ºF.

Edit HR2400 Configuration

Enter the file to be edited

KEY STROKE EXPLANATION

Test < Enter > Checking Input File for errors will appear. If file is
not corrupted, Edit Menu will appear.

Note: If you have a file error, resave your file from recorder. (Refer to save configuration from

recorder.)
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Edit Menu

To edit one of the following, use the instructions on the following pages:

< F1 > RANGES
< F2 > ALARMS
< F3 > INTERPOLATION
< F4 > ZONES/PARTIAL/PRINT FORMAT
< F5 > TAGS/MESSAGES/HEADERS/TITLE
< F6 > CHART SPEEDS/INTERVALS/SYSTEM
< F7 > MOVING AVERAGE
< F8 > USER LINEARIZATION
< F9 > MATH CHANNELS
< F10 > END EDIT

For an explanation of items < Fl > to < F7 >, refer to  IM 3760-OlE. < F8 >, refer to  IM 3760-70E.
< F9 >, refer to  IM 3760-70E.

Ranges

From Edit Menu

KEY STROKE EXPLANATION

< Fl > Ranges.
Channel will be highlighted.

< � >< � > Select channel to be edited. (For example: Stop on Channel 1.)
< Tab > Mode will be highlighted.
< � > Change input type. (For example: Stop on Volt.)

The following items may be selected:

VOLT (Voltage ranges from 20mV to 50 volts DC)
TC (Thermocouples) R, S, B, K, E, J, T, L, U, N, W, KPAUFE
RTD (Resistance Ptl, Pt2, Pt3, Pt4, Pt5, Pt6, Pt7,
    Temp Detector) Pt8, Pt9, J263, Nil, Ni2, Ni3, Cul, Cu2, Cu3, Cu4
UL (USER LINEARIZATION) See note below.
ACV (AC volts) See note below.
ACA (AC Amps) See note below.
RRJC (Remote reference junction compensation) This item must be Setup

in the Edit Menu before selection can be made. See note below.
DELTA (Difference computations) Not available for channel #1 or scaled

channels.
Scale Linear scaling applied to VOLT, TC, RTD inputs.



VARILINK ™
HR2400 Recorders

IM VARILINK™ 1.4

© 1995 Yokogawa Corporation

3rd Edition, January 1995

57

Skip (Channel off)
DI (Digital input)

Note: Special options (UL, RRJC) and MATH must be specified when recorder is ordered. Please

check the model number to verify option. Refer to  IM 3760-70E. or  IM 3760-70E. for

more information.

KEY STROKE EXPLANATION

< Tab > Alarm channel will be highlighted.
< � >< � > Select appropriate range. (6V)
< Tab > Left Span will be highlighted. This is left span (0% value).
1 < Enter > Low end input value.
< Tab > Right Span (100% value).
5 < Enter > High end input value.
< Tab > Scaling will be highlighted.
< � >< � > Turn scaling On or Off. If Off, setting is complete. If On, proceed

below.
< Tab > Left scale will be highlighted:
0.0 < Enter > Left scale value.
< Tab > Right scale will be highlighted:
100.0 < Enter > Right scale value.
< Tab > Units will be highlighted. Maximum 6 characters.
GPM < Enter >
< Tab > This will return you to Channel number . (Setting is complete.)
< F10 > When all range settings are complete.

Note: Left span value and right span value must not be equal.

 Alarms

From Edit Menu

KEY STROKE EXPLANATION
< F2 > For alarm editing.
< � >< � > Select channel number or enter
01 < Enter > Channel number to be edited.
< Tab > Level will be highlighted.
< � >< � > Set level number 1-6.
< Tab > Status will be highlighted.
< � >< � > To turn Alarm On or Off. (If “Off” is selected, setting is complete.)

Turn alarm On.”
< Tab > Alarm will be highlighted.
< � >< � > To change H = High, L = Low, RH = Rate of change High, RL = Rate

of change Low, dH = Delta High, dL = Delta Low.
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Note: dH and dL to be used on "DELTA" channels only.

< Tab > Set Point will be highlighted.
50 < Enter > Select Set Point value.
< Tab > Relay will be highlighted.
< � >< � > Turn relay On or Off. If Off, setting is complete. Turn relay “On”
< Tab > Relay number will be highlighted.
< � >< � > Select Internal, External, or Switch (refer to HR2400  IM 3760-OlE.

for further explanation of this function).

After all Alarms and Relay have been set,

KEY STROKE EXPLANATION

< F10 > Prior Menu.

Note: If your recorder is equipped with AK-02 or AK-10, you have 2 or 10 internal alarms,

respectively. If you have an external alarm unit, then you have 30 or 60 external alarm

contacts.

Interpolation

KEY STROKE EXPLANATION

< F3 > INTERPOLATION
Channel will be highlighted.

< � >< � > Select channel number for channel you wish to turn
Interpolation On or Off.

< Tab > Status will be highlighted.
< � > Turn On Interpolation.
< � > Turn Off Interpolation.
< F10 > Prior Menu.

Note: The maximum number of channels that Interpolation can be turned on is 10. Also,

Interpolation can only be used in the trend mode of the recorder.

For more information on Interpolation, refer to HR2400  IM 3760-01E. Initially, all channels are set
for Interpolation to be Off.
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Zones/Partial/Print Format

From Edit Menu

KEY STROKE EXPLANATION

< F4 > Zones/Partial/Print Format.
Select item to be edited

< F1 > Zones
< F2 > Partial
< F3 > Print Format
< F10 > Prior Menu

Zones

From Zones/Partials/Print Format

KEY STROKE EXPLANATION

< Fl > Zones.
Channel number will be highli ghted.

< � >< � > Select Channel number (zones can be set for each channel,
default value 0-250 mm).

< Tab > Left Zone will be highlighted. Set Value. (minimum)
0 < Enter >
< Tab > Right Zone will be highlighted. Set value. (maximum)
250 < Enter >
< F10 > Prior Menu.

Note: The minimum width for a zone is 5mm. The maximum setting is 250mm. For more

information on Zones, refer to HR2400  IM 3760-OlE.

Partial

From Zones, Partial and Print Format

KEY STROKE EXPLANATION

< F2 > Partial.
< � >< � > Channel number will be highlighted. Set channel number

(Partials must be set On or Off for each channel).
< Tab > Status will be highlighted.
< � >< � > Turn On Partial.
< Tab > Percent will be highlighted.

Set percentage.



VARILINK ™
HR2400 Recorders

IM VARILINK™ 1.4

© 1995 Yokogawa Corporation

3rd Edition, January 1995

60

25 < Enter >
< Tab > Limit will be highlighted.

Set value.
10 < Enter >

After all Partials are set:
< F10 > Prior Menu.

For more information on Partial, see HR2400  IM 3760-OlE.

Print Format

From Zones, Partial and Print Format

KEY STROKE EXPLANATION
< F3 > Print Format
< � >< � > Channel will be highlighted.  Set channel number.
< Tab > Trend Printing will be highlighted.
< � >< � > Turn Trending On or Off .
< Tab > Digital Printing will be highlighted.
< � >< � > Turn Digital printing On or Off.

After print format has been set for all channels,
< F10 > 2 times Edit Menu.

Tags/Messages/Headers/Title

From Edit Menu

KEY STROKE EXPLANATION

< F5 > Tags/Messages/Headers/Tit1e
Select item to be edited:

< F1 > Title
< F2 > Messages
< F3 > Headers
< F4 > Tags
< F10 > Prior Menu
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Title
From Tags, Messages and Headers

KEY STROKE EXPLANATION

< Fl > Title.
Enter the Title you want to install in recorder up to 32 characters.

HR2400 < Enter >
< F10 > Prior Menu.

Messages

From Tags, Messages and Headers

KEY STROKE EXPLANATION

< F2 > Messages.
< � >< � > Select one of the following:
< Panel >
< Cont 1 > Remote Control Message 1
< Cont 2 > Remote Control Message 2
< Cont 3 > Remote Control Message 3
< Cont 4 > Remote Control Message 4
< Cont 5 > Remote Control Message 5

< ALM 1 > Alarm condition 1 dependent message 1
< ALM 2 > Alarm condition 2 dependent message 2
< ALM 3 > Alarm condition 3 dependent message 3
< ALM 4 > Alarm condition 4 dependent message 4
< ALM 5 > Alarm condition 5 dependent message 5

Message < Enter > (maximum of 16 characters).
< F10 > Prior Menu.

For further information, see  IM 3760-OlE.
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Headers

From Tags, Messages and Headers

KEY STROKE  EXPLANATION

< F3 > Headers.
< � >< � > Select Header number. (Maximum of 5 Headers.)

(Maximum of 80 characters.)
Boiler I < Enter >
< � >< � > Change Header number.
Boiler 2 < Enter > Type information.

When complete,
< F10 > Prior Menu.

Tags

From Tags, Messages and Headers

 KEY STROKE EXPLANATION

< F4 >  Tags.
< � >< � >  Tag number will be highlighted. Change Tag number.
< Tab >  Tag Name will be highlighted.

 Type in Tag Name. (maximum of 7 characters)
FT-101 < Enter >  When all Tags have been entered,
< F10 > 2 times  Edit Menu.

Chart Speeds/Intervals/System

From Edit Menu

 KEY STROKE EXPLANATION

< F6 > Chart Speeds/Intervals/System
Select item to be edited

< F1 > Chart Speed
< F2 > Chart Speed 2
< F3 > Interval
< F4 > System
< F10 > Prior Menu
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Chart Speed

From Chart Speed and Intervals

 KEY STROKE EXPLANATION

< Fl > Chart Speed.
500 < Enter > Chart Speed will be highlighted. Set Chart Speed in MM/H (1-1500

MM/H).
< F10 > Prior Menu

Chart Speed 2

From Chart Speed and Intervals

KEY STROKE EXPLANATION

< F2 > Chart Speed 2
Chart Speed will be highlighted. Set new Chart Speed.
(1-1500 MM/H).

500 < Enter >
< Tab > Interval will be highlighted (00:00 24:00) in the  HH:MM

format. Set interval.
< F10 > Prior Menu.

Note: This is the Chart Speed and Interval used when change on Alarm or Remote Control is in

effect. For further information, see  IM 3760-OlE.

Interval

From Chart Speed and Intervals

KEY STROKE EXPLANATION

< F3 > Intervals
Interval 1 will be highlighted. Set Interval 1 (00:00-24:00). See
note below .

01 :00 < Enter >
< Tab > Interval 2 will be highlighted. Set Interval 2 (00:00 -24:00).
02:00 < Enter >
< Tab > Interval 3 will be highlighted. Set Interval 3 (00:00-24:00).
03:00 < Enter >
< Tab > Start Time will be highlighted. See note below.
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< � >< � > Turn On or Off. If Start Time On was selected,
< Tab > Start Date will be highlighted.
91/07/01 < Enter > Type Start Date YY/MM/DD.
< Tab > Start Time will be highlighted.
08:00 < Enter > Type Start Time HH/MM.
< F10 > Prior Menu when complete.

Note: You must have multiple (rather than single) setup in the “Setup Mode” of the recorder to

have more than one interval.

If single was selected in Setup Mode, the start time and start date are not available. If you need more
information, refer to  IM 3760-OlE.

System

From Chart Speed and Intervals

KEY STROKE EXPLANATION
< F4 > System.

Trend/Log will be highlighted.
< � >< � > Select Trend Mode or Logging Mode.
< Tab > Alarm print will be highlighted.
< � >< � > Select Change or None
< Tab > Recording Mode.
< � >< � > Change from auto or fix
< F10 > 2 times Return to Edit Menu.

Note: For more information, refer to  IM 3760-OlE.

Moving Average

From Edit Menu

KEY STROKE EXPLANATION

< F7 > Moving Average Interpolation.
Moving Average will be highlighted. Enter channel number .

01 < Enter >
< Tab > Status will be highlighted.
< � >< � > Turn On or Off Moving Average for that channel.
< F10 > Return to Edit Menu.

Note: For more information on Moving Average, refer to  IM 3760-OlE.
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User Linearization*

*This option will only appear when the user linearization option is fitted.

From Edit Menu

KEY STROKE EXPLANATION

< F8 > User Linearization. Curve will be highlighted.
< � >< � > Select curve 1, 2, or 3. Once you have selected the curve,
< Tab > Status will be highlighted.
< � >< � > Turn Status On or Off. If off is selected, setting is complete.
< Tab > Range will be highlighted,
< � >< � > Select voltage range 2OmV, 6OmV, 200mV, 2V, 6V, 20V,

or 50 volts;
< Tab > Compensation will be highlighted.
< � >< � > Select Ext. = External, Internal ºF or Internal ºC.

External is used when fixed or no reference junction compensation
is required. Internal ºF is used when Reference Junction
Compensation is required in ºF. Internal ºC is used when Reference
Junction compensation is required in ºC.

< Tab > Decimal is highlighted,
< � >< � > Select number of decimal points to be used (0-4).
< Tab > Units is highlighted. Maximum 7 characters.
F < Enter >
< Tab > Point # is highlighted Type number of point to be edited (0-32).
1 < Enter >
< Tab > Value is highlighted. Enter voltage input value.
0.000 < Enter >
< Tab > Scale is highlighted. Enter voltage output value.
0.0 < Enter >
< Shift >< Tab > Twice to return to point number. Repeat the above procedure

until all desired points are set.

Note: For more information, refer to  IM 3760-70E.

< F10 > Return to Edit Menu.



VARILINK ™
HR2400 Recorders

IM VARILINK™ 1.4

© 1995 Yokogawa Corporation

3rd Edition, January 1995

66

 Math Channels*

From Edit Menu

KEY STROKE EXPLANATION
< F9 > Math Menu

Select item to be edited
< F1 > Math Channels
< F2 > Constant
< F10 > Prior Menu

< Fl > Math Channels*. Channel number will be highlighted.
< � >< � > Set Math Channel desired (31-60) or type in channel number.
31 < Enter >
< Tab > Status will be highlighted.
< � >< � > Turn channel On or Off channel. Keep channel On.
< Tab > Expression will be highlighted. To enter a math expression type

expression,
Ol.GT.02 < Enter >

To edit expression,
< � > Until cursor is under item to be changed, type desired change.
Change < Enter > To insert items into a math statement,
< � > Cursor is under the point you wish to insert,
< Insert > Item Type item to be inserted,
< Enter > You may also delete items from a math statement.
< � > To move the cursor to the desired item to be deleted,
< Delete > Item
< Enter > When complete.
< Tab > Left span value is highlighted. Set value.
0 < Enter >
< Tab > Right span value is highlighted. Set value.
1 < Enter >
< Tab > Units is highlighted. Set units.
Tons < Enter >
< F10 > 2 times Return to Edit Menu, when all math channels are complete.

Note: For further information on math, see  IM 3760-60E.

Note: *This display will only appear when the MATH option is fitted.

Note: Left span value and right span value must not be equal.
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Constants*

From Edit Menu

KEY STROKE EXPLANATION

< F9 > Math channels*.
< F2 > Constants.
< � >< � > Constants number is highlighted. There are 30 constants (01-30).

Choose the Constant number to edit,
< Tab > Set Constant value.
1.234 < Enter >

When all Constants have been set:
< F10 > 2 times Return to Edit Menu.

Note: The Constant lE+29 cannot be set in this software. You must enter this Constant at the

recorder. For more information on setting Constants, refer to  IM 3760-60E.

Note: *This display will only appear when the math option is fitted.

End Edit

From Edit Menu

KEY STROKE EXPLANATION

< F10 > End Edit.
Do you wish to save changes?

< Fl > Yes.
< F2 > No.

Load Configuration to Recorder

From Edit Menu

KEY STROKE EXPLANATION

< F6 > Load configuration to recorder . Enter instrument number .
l < Enter > Instrument number.

Enter filename to load configuration data (without extension)
Test < Enter >
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Note: When load starts, an error list will appear on the screen. Data loaded into the recorder will

be displayed in the lower left hand corner of the screen. This will take a few minutes.

When complete,
< F10 > Prior Menu.
< F10 > Prior Menu.
< F10 > End Program.
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HR/DA 2500
Software Limitations

Items in the Setup Mode of the HR2500 recorder or the DA2500 Data Acquisition System cannot be
set from VARILINK™ 1.4, refer to IM3880-05E. Item 5 in the Random Mode can only be set at the
recorder; refer to IM3880-05E.

The clock in the recorder cannot be accessed or set through VARILINK™ 1.4.

The following items can be configured from VARILINK™ 1.4: Ranges, Alarms, Groups, Print
Format, Tag and Messages, Chart Speeds/ Intervals, List Format, Pulse Input, Math Channel and
Constants.

Exception: The constant lE + 29 may not be entered through this software.

Requirements

1. IBM or compatible computer with a RS232C port;
2. DOS 2.1 or higher;
3. Johnson Yokogawa Corporation VARILINK™ 1.4 software;
4. For recorder with RS232C;

a) Null Modem cable.
b) RS232C port on computer.

Recorder/Data Acquisition Setup

The HR/DA2500 must be set to the following parameters in the Setup Mode. The Setup Mode can
be accessed by setting the setup dip switch to the “On” position (the dip switch is located on the rear
of the HR/DA2500 and is labeled setup). Cycle the power to the recorder while pressing the Aux key
(the Aux key is on the engineering keyboard located at the bottom of the recorder door. For more
information, refer to IM3880-05E (4th edition) pages 31-32. Press Aux Key and hold until SETUP
MODE appears on the digital display (approximately 15 seconds).

KEYSTROKE EXPLANATION UPPER DISPLAY

< Next > Located on the right side of the engineering keyboard SETUP MODE SET 1
< F2 > COMM SETUP MODE = COMM
< Enter > 3 times, BAUD RATE BAUD RATES =
< Next >
< F4 > 9600 BAUD RATES = 9600
< Enter > STOP BIT STOP BITS =
< Fl > 1 STOP BITS = 1
< Enter > PARITY PARITY =
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< F3 > PARITY= NONE PARITY = NONE
< Enter > DATA BITS DATA BITS =
< F2 >  8 DATA BITS = 8
< Enter > HANDSHAKE HANDSHAKE =
< F3 > XON:RS HANDSHAKE = XON:RS
< Enter > RS232C MODE RS232C MODE =
< Fl > SET AND OUT RS232C MODE = SET & OUT
< Enter > 2 times ***SETUP COMM COMPLETE***
< Enter > GPIB MODE = SET
< F4 > ESCAPE GPIB MODE = ESC
< Enter > SETUP MODE SETUP MODE = COMM
< F4 > END SETUP MODE = END
< Enter > TO RUN MODE DISPLAY

The HR/DA2500 is now set up to communicate with the computer.

Connect null modem cable between recorder and computer.

Computer Setup

Boot-up computer on DOS and install Johnson Yokogawa Corporation VARILINK™ 1.4 software in
your disk drive.

KEY STROKE EXPLANATION

VARILINK™ < Enter > After a moment, the Main Menu will appear as follows:

< Fl > Display & Data Acquisition menu
< F2 > Edit configuration
< F3 > Setup Computer
< F4 > Save All Setup Parameter
< F5 > Save Configuration From Recorder
< F6 > Load Configuration to Recorder
< F7 > HR2400 IC Card
< F8 > HR2400 Reports
< F10 > End program

KEY STROKE EXPLANATION

From Main Menu

< F3 > Setup Computer

< Fl > Setup Com Ports
< F2 > Select Devices
< F10 > Prior Menu



VARILINK ™

HR/DA 2500 Recorders

IM VARILINK™ 1.4

© 1995 Yokogawa Corporation

3rd Edition, January 1995

71

KEY STROKE EXPLANATION

< Fl > Change Com Port 1
< F2 > Change Com Port 2
< F3 > Change Com Port 3
< F4 > Change Com Port 4

< F10 > Return to Setup Computer Menu

Repeatedly pressing the appropriate function key will scroll the various Baud rate choices.
((minimum = 300, maximum = 9600) Select the appropriate rate:

KEY STROKE EXPLANATION

From Setup Computer Menu
< F2 > Select Devices

Configured Devices
< F2 > Device Number:
< F3 > Device Type:
< F4 > Start Channel:
< F5 > End Channel:
< F6 > Interface:
< F10 > Prior Menu

< F2 > Select Devices. Enter number of device to be edited.
1 < Enter >
< F3 > Device type. Repeat until HR2500 appears.
< F4 > Start channel (sequential order, lowest contiguous channel)

Note: Channel numbers must be selected from the following sequences:

Input Channels (001-060), (101-160), (201-260), or (301-360).

Math Channels (A01-A60)

All channel numbers must be 3 characters in length.

001< Enter >
< F5 > End channel (sequential order, highest contiguous channel)
060 < Enter >
< F6 > Interface. Press repeatedly to select your Com Port. (This is

the Com Port on your computer to which you have connected the
HR/DA2500.)

If you do not want to save all channels for Data Acquisition/ Display, you will have to set up more
than one device.

Example: You have an HR/DA2500 with 60 input channels and a 30 input remote scanner

(channels 101-130). The HR/DA2500 mainframe has the math option (A01-A60). You

only want to acquire data from channels 001-020, 101-120 and A05-A10. You must do

the following:
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Device 1:

Device Type = HR2500

Start Channel = 001

End Channel = 020

Device 2:

Device Type = HR2500

Start Channel = 101

End Channel = 120

Device 3:

Device Type = HR2500

Start Channel = A01

End Channel = A10

KEY STROKE EXPLANATION

From Set-Up Computer Menu

< F2 > Select devices.
Configured Devices

1< Enter > Enter number of device to be edited.

Note: For Data Display and Acquisition, device types are limited to only those devices which are

connected to the computer. Failure to do so will stop the program! A maximum of 144

devices may be set.

< F3 > Device type. Repeat until HR2500 appears.
< F4 > Start channel
001 < Enter >
< F5 > End channel

Note: A maximum of 1,200 channels may be selected.

020 < Enter >
< F2 > Device number
2 < Enter > Enter number of device to be edited.
< F3 > Device type. Repeat until HR2500 appears.
< F4 > Start channel
101 < Enter > Enter number of device to be edited.
< F5 > End channel
120 < Enter >
< F2 > Device number
3 < Enter >
< F3 > Device type. Repeat until HR2500 appears.
< F4 > Start channel.
A05< Enter >
< F5 > End channel.
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A10< Enter >
< F10 > 3 times Return to Main Menu.
< F4 > Save all setup parameters

Note: The computer is now set up to communicate with the HR/DA2500.

Display and Data Acquisition Menu

From the Main Menu,

KEY STROKE EXPLANATION

< Fl > Display and Data Acquisition Menu.  Setup Data
Acquisition Menu will appear.

Setup Data Acquisition

< Fl > Help
< F2 > Sampling rate: (seconds)
< F3 > File name to store data to: (your file name)
< F4 > File type:
< F5 > Number of rows in data file: (samples per channel)
< F6 > Number of columns in data file: (number of

channels)
< F8 > Save All Setup Parameters
< F9 > Start Main Program (start Display or Data Acquisition)
< F10 > Prior Menu

Note: Spreadsheet software places a limitation on the number of columns that are available for

use in data acquisition. The limit is 250 columns, or as used in VARILINK™ 1.4, a total

of 250 Channels. When the number of channels to be acquired exceeds 250, VARILINK™

1.4 will automatically write multiple files to disk to accomodate the excess over the 250

limit. See example #1 below.

The ability to write multiple files simultaneously could also be used to segregate data as

desied. See example #2 below.

Example 1: (HR2500 with 300 channels saved to disk)

Set number of columns to 250, File Name = Test.
VARILINK™ 1.4 will save information to 2 files.
File Name #1 will be TESTA00.WKl (Inputs 1-250).
File Name #2 will be TESTB00.WKl (Inputs 251-300).
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Example 2: (HR2500 with 30 channels saved to disk)

Set number of columns to 10, File Name = Test.
VARILINK™ 1.4 will save information to 3 files.
File Name #1 will be TESTA00.WKl (Channels 01-10)
File Name #2 will be TESTB00.WKl (Channels 11-20)
File Name #3 will be TESTC00.WKl (Channels 21-30)

Note: The maximum number of files that can be created is 14.

KEY STROKE EXPLANATION

< Fl > For a help screen for Data Acquisition.
< F10 > To return to Setup Data Acquisition Menu.
< F2 > Sampling rate; this setting is in seconds: minimum setting is

2 seconds, maximum setting is 21,600 seconds or 6 hours. This
setting determines how often data is saved from the recorder to the
file.

2 < Enter >
< F3 > File name to store data to: Enter complete path and

your own file name with a maximum of 5 characters.
Test < Enter >
< F4 > File type: you have 2 choices: .WKl (Lotus spreadsheet

format) or .DIF (Data interchange format). Press < F4 > (each
time you press < F4 > . WKl and . DIF toggles on the screen).

< F5 > Number of rows in data file; minimum 500, maximum
8,180. This is the number of samples of each acquired channel to be
stored in each file.

1000 < Enter > 1000 samples of each acquired channel will be taken before a new
file is created.

< F6 > Number of columns in data file: minimum 1
column, maximum 250 columns. This is the number of channels to
be saved to a file.

Example: HR/DA2500 with 60 input channels. Also, you have the math
option 60 channels (A01-A60).

120 < Enter > However, to save only channels 001-012,
12 < Enter >
< F8 > Save all setup parameters: this will save the settings

< F2 > through < F6 > to the default file for Data Acquisition.
< F9 > Start data program. The computer screen will display

TESTING COMMUNICATIONS, reading data from the HR/
DA2500. At the bottom left of the screen you will observe data
being read from the HR/DA2500, after approximately one minute
Main Data Menu will appear.
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Main Data Menu

< F1 > Display Data
< F2 > Data Acquisition
< F3 > HR2400 IC Card
< Fl0 > Main Menu

Display Data

From Data Menu

KEY STROKE EXPLANATION

< F1 > Display data.
< � >< � > To scroll through channels.
< Page Up > Scrolls pages of channels. (Or you may type the defined Tag name
< Page Down > of the channel you wish displayed.)

Example: You would like to display channel 20:

KEY STROKE EXPLANATION

1HR25 020< Enter > Tag name is displayed in selected channel. (Channel 20 at top of
page).

< F10 > Return to Main Data Menu.

Data Acquisition

From Data Menu

KEY STROKE EXPLANATION

< F2 > Data Acquisition.
Start/Stop Data Acquisition Menu will ap pear. At this
point in the program you may change any of the parameter < F2 >
through < F6 > described in the Data Acquisition Menu
section discussed earlier.

< Fl > Start Data Acquisition.

Note: The number of samples taken is displayed in the lower left portion of the screen. Also, the

current file is displayed to the right of samples taken. Once a file is full, the program will

create another file automatically. A maximum of 224 files will be created. However, if disk

space is depleted, program will stop.
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File creation Example: File name = Test
Current File: Test?00 will appear, once this file is full, the current file

Test?01 will appear.

Note: After Data Acquisition is complete, the Menu will return to Start/Stop Data
Acquisition. If < F1 > is pressed and the file name has not been changed, a box will

appear under < F10 > Print Menu: Do you want to overwrite the
existing files (Y/N). If Y is selected, the current file will be overwritten.

KEY STROKE EXPLANATION

< Fl > Stop Data Acquisition when Data Acquisition is
complete.

< F10 > Return to Main Data Menu.
< F10 > Return to Main Menu.

Edit Configuration

Caution: The HR2500 recorder has 2 formats of operation
1. Trend
2. Logging

You must save the configuration from the recorder while the recorder is in the Trend or Logging
format. Editing can only be accomplished for the Trend format if you save the configuration while
the recorder is in the Trend mode. Likewise, editing can only be accomplished for the Logging
format if you saved the configuration while the recorder or Data Acquisition system was in the
Logging mode.

Note: The DA2500 has only the Logging format.

Save Configuration From Recorder

From Main Menu

KEY STROKE EXPLANATION

Note: A configuration file must be in the default directory before "Edit Configuration" can

begin.

If you have a new disk or a disk that does not have an existing file.

Note: Configuration files are .25 extension files.
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< F5 > Save configuration from recorder.
Enter instrument number: (1-144)

1 < Enter >
Enter File name to save configuration (without
extension)

Trend < Enter >

Note: VARILINK™ 1.4 will save data from all channels from HR/DA2500 to the default

operating directory. The screen will flash WORKING! When Save configuration is

complete, the program will return to the Main Menu.

Edit Configuration

From Main Menu

KEY STROKE EXPLANATION

< F2 > Edit configuration.
Select instrument to edit

< F1 > HR2400
< F2 > HR2500
< F3 > µR1000/1800
< F10 > Prior Menu

< F2 > HR2500

Temperature Units

Select ºF or ºC

KEY STROKE EXPLANATION

< Fl > ºF
< F2 > ºC

Note: This selection does not change recorder setup for temperature. The change can only be

made in the Setup Mode of the recorder. If you do not have temperature inputs, select

< F1 > ºF.
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Edit HR2500 Configuration

Enter file to be edited

KEY STROKE EXPLANATION

Trend< Enter > Checking input file for errors will appear.
When check is complete, Edit Menu will appear on screen.

Note: If you have a file error, resave your file from recorder (refer to Save configuration from

the recorder section of this document).

Edit Menu

From Edit HR2500 Configuration

Select Item to be edited

To edit one of the following, use the instructions on the following pages:

< F1 > RANGES
< F2 > ALARMS
< F3 > GROUPS
< F4 > PRINT FORMAT
< F5 > TAGS & MESSAGES
< F6 > CHART SPEEDS/INTERVAL
< F7 > LIST FORMAT
< F8 > PULSE INPUT
< F9 > MATH CHANNELS AND CONSTANTS
< F10 > END EDIT

For an explanation of items < F1 > to < F7 >, refer to IM3880-05E. < F8 >, refer to IM3880-90E. <
F9 >, refer to IM3880-60E.

Ranges (Trend or Logging Format)

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< Fl > Ranges.
< � >< � > Channel will be highlighted. Select the channel to be edited.

(For example: Stop on Channel 1.)
< Tab > Mode will be highlighted.
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 < � > To change mode. (For example: Stop on Normal.)

The following modes may be selected:

Normal Select this mode when standard ranges are used.

Delta Channel
(Delta ch) Measure and display the difference of the current measured value from

the measured value in the reference channel.

Delta First Measure the difference of the current measured value from the measured
value of the initial measured value in the set channel.

Delta Last Measures the difference between the current measured value and the
value one scan before in the set channel.

Remote RJC Measured value of the RJC channel is the RJC value of the channel
which is set currently and the measurement and display are executed
(Remote RJC). A temperature input must be set in a prior channel in
order to utilize this mode.

Skip Use this mode when the channel is not to be used.

Note: For more information on the mode setting, refer to IM3880-05E.

KEY STROKE EXPLANATION

< Tab > Range will be highlighted.
< � >< � > To change range. (For example: Stop on 6V range.)

The following items may be selected:

VOLTAGE THERMOCOUPLES RTDs DIGITAL INPUTS
20 mV Type R Pt100:1 VOLTS DI1
60 mV Type S Pt100:2 CONTACT DI2
200 mV Type B Pt 50:2
2 VOLTS Type K Ni100S
6 VOLTS Type E Ni100D
20 VOLTS Type J Ni100:1
50 VOLTS Type T Ni120:1

Type L Cu101
Type U Cu102
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Type N CU103
Type W CU104

Note: Certain items in the above section are dependent on the standard selected in the setup

mode of the Recorder/Acquisition System. For more information refer to the IM3880-05E

for the HR2500 or IM3890-05E for the DA2500.

KEY STROKE EXPLANATION

If in Logging Format, skip to Scaling Setup.
< Tab > Left Span will be highlighted. This is the
1 < Enter > Left Span (0% value).
< Tab > Right Span will be highlighted. This is the Right Span. (100%

value).
5 < Enter >
< Tab > To turn scaling On or off. If scaling is turned off, setting is

complete. If scaling is turned on Left Scale, Right Scale
and Unit will appear at bottom of the screen.

< � > (For example: Turn scaling On.)
< Tab > Left Scale will be highlighted:
0 < Enter > Left Scale value. (For example: 0.)
< Tab > Right Scale will be highlighted:
100 < Enter > Right Scale value. (For example: 100.)
< Tab > Units will be highlighted.
pph < Enter > (For example: pph.)
< Tab > This will return you to channel number (setting is complete).
< F10 > When all range settings are complete.

Alarms
From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F2 > Alarms
< � >< � > Channel will be highlighted. Select channel number or
001< Enter > Channel number to be edited.
< Tab > Level will be highlighted.
< � >< � > Set desired level number, 1-4
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< Tab > Status will be highlighted.
 < � >< � > To turn alarm On or Off if status = Off setting is complete. If

status = On proceed as follows:
< Tab > Alarm will be highlighted.
< � >< � > To change H=High, L=Low, RH=Rate of change high, RL=Rate of

change low, dH=Delta High, dL=Delta Low.
< Tab > Set Point will be highlighted.
10 < Enter > Set Set Point value.
< Tab > Hysteresis will be highlighted.
.1 < Enter > Set Hysteresis value.
< Tab > Print will be highlighted.
< � >< � > To turn print On or Off
< Tab > Relay will be highlighted.
< � >< � > To turn relay On or Off. If relay = Off, setting is complete. If

Relay = On, then:
< Tab > Relay # will be highlighted.
< � >< � > Select Internal I01 through I10 or E01 through E60.

Note: For more information refer to the HR2500 IM3880-05E or the DA2500 IM3890-05E.

Note: If your recorder is equipped with AK10, you have 10 internal alarms. If you have an

External Alarm Unit, you have 30 or 60 external alarm contacts.

After all alarms and relays have been set,

KEY STROKE EXPLANATION

< F10 > Return to Edit HR2500 Configuration menu.

Groups

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F3 > Groups
< � >< � > Group number is highlighted. Select groups G01 through G30.
< Tab > TYPE is highlighted.
< � >< � > Choose All Ch = All Channels or Select. If All Ch is

selected, setting is complete. If Select was chosen, proceed as
follows:

< Tab > GROUP is highlighted.
001-030 < Enter > Type in the channels for this group.

Note: For more information on groups, refer to the HR2500 IM3880-05E or the DA2500

IM3890-05E.
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When all groups are set,

KEY STROKE EXPLANATION

< F10 > Return to Edit HR2500 Configuration menu.

Print Format (Trend Format)

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F4 > Print Format
Print Format

CHANNEL will be highlighted.
< � >< � > Select Channel Number or
020 < Enter > Type channel number to be edited.
< Tab > TREND will be highlighted.
< � >< � > Trend On or Off
< Tab > DIGITAL will be highlighted.
< � >< � > Digital On or Off
< Tab > SCALE will be highlighted.
< � >< � > Scale On or Off
< Tab > MAN PRINT will be highlighted
< � >< � > Manual Print On or Off
< Tab > LOG INTERVAL will be highlighted
< � >< � > Select 1 through 6 or RMT. (RMT = Remote)
< Tab > LEFT ZONE will be highlighted.
0 < Enter > Set minimum (0% value)
< Tab > RIGHT ZONE will be highlighted
250 < Enter > Set maximum (100% value)
< Tab > PARTIAL will be highlighted
< � >< � > Partial On or Off
< Tab > CHANNEL will be highlighted

Repeat above procedure for all channels

< F10 > Prior Menu when complete
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Print Format (Logging Format)

KEYSTROKE EXPLANATION

< F4 > Print Format
Print Format

CHANNEL will be highlighted.
< � >< � > Select channel number or
020 < Enter > Type CHANNEL number to be edited
< Tab > DIGITAL will be highlighted
< � >< � > To turn Digital On or Off
< Tab > MAN PRINT = Manual Print will be highlighted
< � >< � > To turn Manual Print On or Off
< Tab > LOG INTERVAL = Logging Interval will be highlighted.
< � >< � > Select Logging Interval 1 through 6 or RMT = Remote

Note: For more information, refer to the HR2500 IM3880-05E.

When all print format set items are complete,

KEYSTROKE EXPLANATION

< F10 > Return to Edit HR2500 Configuration Menu

Tags, Messages and Title

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F5 > Tag and messages
Tags and Messages

< F1 > Tags
< F2 > Messages
< F3 > Title
< F10 > Prior Menu
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Tags

KEY STROKE EXPLANATION

< Fl > Tags
TAG NUMBER will be highlighted.

< � >< � > Select Channel Number or
020 < Enter > Channel Number to be edited
< Tab > TAG NAME will be highlighted.
FT-101< Enter > Type in Tag (maximum 7 characters)

When all Tags have been entered

< F10 > Return to Tags And Messages Menu

Messages

From Tags and Messages

KEY STROKE EXPLANATION

< F2 > MESSAGES
MESSAGE NUMBER will be highlighted.

< � >< � > Select message number (maximum 4 messages)
< Tab > Message will be highlighted.
HR2500< Enter >
< Tab > When all messages are complete

< F10 > Return to Tags And Messages Menu

Title

From Tags and Messages

KEY STROKE EXPLANATION

< F3 > Title. Type title (maximum 32 characters)
BOILER < Enter >

When complete,

< F10 > Return to Edit HR2500 Configuration Menu.
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Chart Speeds/Intervals (Trend Format)

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F6 > Chart Speeds/Intervals
SCAN SPEED will be highlighted.

02 < Enter > (02-60 seconds)
< Tab > START TIME will be highlighted.
< � >< � > Select On or Off
< Tab > START DATE will be highlighted.
91/07/01 < Enter > Set Start Date
< Tab > START TIME will be highlighted.
08:00:00 < Enter > Set Start Time.
< Tab > CHART SPEED will be highlighted.
25 < Enter > Set Chart Speed (MM/HR )
< Tab > MODE will be highlighted.

Select AUTO, FIX
If AUTO was selected pressing tab will highlight interval 1.

< Tab > If FIX was selected TREND INTERVAL will be highlighted.
02 < Enter > Set Trend Interval
< Tab > INTERVAL 1 will be highlighted.
08:00 < Enter > Set Interval 1 (00:01 to 24:00)
< Tab > INTERVAL 2 will be highlighted.
01:00 < Enter > Set Interval 2
< Tab > INTERVAL 3 will be highlighted.
00:45 < Enter > Set Interval 3
< Tab > INTERVAL 4 will be highlighted.
00:30 < Enter > Set Interval 4
< Tab > INTERVAL 5 will be highlighted.
00:15 < Enter > Set Interval 5
< Tab > INTERVAL 6 will be highlighted.
00:01 < Enter > Set Interval 6
< Tab > CHART SPEED will be highlighted.
100 < Enter > Set remote chart speed
< Tab > MODE will be highlighted.
< � >< � > Select remote mode (Auto or fix)

If AUTO is selected pressing tab will highlight Interval 1.
If FIX is selected press tab

< Tab > TREND INTERVAL will be highlighted
06 < Enter > Set Interval (01 to 60 seconds)
< Tab > INTERVAL 1 will be highlighted.
00:02 < Enter > Set Interval 1

< F10 > Return to Edit HR2500 Configuration Menu.
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Chart Speeds/Intervals (Logging Format)

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F6 > Chart Speeds /Intervals
SCAN INTERVAL will be highlighted.

02 < Enter > Set Scan Interval (02-60 seconds)
< Tab > START TIME will be highlighted.
< � >< � > Turn On or Off
< Tab > START DATE will be highlighted.
91/07/01 < Enter > Set Start Date
< Tab > START TIME will be highlighted.
00:08:00 < Enter > Set Start Time
< Tab > INTERVAL 1 will be highlighted.
24:00 < Enter > Set Interval 1
< Tab > INTERVAL 2 will be highlighted.
16:00 < Enter > Set Interval 2
< Tab > INTERVAL 3 will be highlighted.
08:00 < Enter > Set Interval 3
< Tab > INTERVAL 4 will be highlighted.
01:00 < Enter > Set Interval 4
< Tab > INTERVAL 5 will be highlighted.
00:03 < Enter > Set Interval 5
< Tab > INTERVAL 6 will be highlighted.
00:01 < Enter > Set Interval 6
< Tab > INTERVAL will be highlighted (remote interval).
00:02 < Enter > Set Interval

< F10 > Return to Edit HR2500 Configuration Menu.

List Format

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F7 > GROUP NUMBER will be highlighted.
01 < Enter > Set group number
< Tab > RANGE LIST will be highlighted.
< � >< � > Turn On or Off
< Tab > ALARM LIST will be highlighted.
< � >< � > Turn On or Off
< Tab > GROUP LIST will be highlighted.
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< � >< � > Turn On or Off
< Tab > PRINT FORMAT will be highlighted.
< � >< � > Turn On or Off
< Tab > BO/RJC LIST will be highlighted.
< � >< � > Turn On or Off
< Tab > OPTION LIST will be highlighted.
< � >< � > Turn On or Off

When complete
< F10 > Return to Edit HR2500 Configuration Menu.

Note: For more information, refer to IM3880-05E

Pulse Input

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F8 > Pulse Input*
Pulse Input

Channel will be highlighted.

Note: *This display will only appear when the pulse train option is fitted.

< � >< � > Select channel or
001 < Enter > Type Channel number
< Tab > Mode will be highlighted.
< � >< � > Select one of the following

Skip Channel off, setting is complete
Operate Measures time contact is closed
Rate Counts pulses per second
Total Counts pulses (Total)
If Operate is selected

< Tab > Filter will be highlighted.
< � >< � > Turn On or Off

If Rate is selected
< Tab > Left Span will be highlighted.
0 < Enter > Set Left Span (0% value)
< Tab > Right Span will be highlighted.
100 < Enter > Set Right Span (100% value)
< Tab > Left Scale will be highlighted.
0:00 < Enter > Set Left Scale value
< Tab > Right Scale will be highlighted.
100.00 < Enter > Set Right Scale
< Tab > Filter will be highlighted.
< � >< � > Turn filter On or Off
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< Tab > Units will be highlighted.
GPM < Enter > Set units

If Total is selected
< Tab > Left Span will be highlighted.
0 < Enter > Set Left Span (0% value)
< Tab > Right Span will be highlighted.
10000 < Enter > Set Right Span (100% value)
< Tab > PLS SCLR will be highlighted.

Note: This is the maximum integration value exponent. For more information, refer to IM3880-

90E.

0 < Enter > Set Exponent (03)
< Tab > Left Scale will be highlighted.
0.0 < Enter > Set Left Scale
< Tab > Right Scale will be highlighted.
10000 < Enter > Set Right Scale
< Tab > Filter will be highlighted.
< � >< � > Turn On or Off
< Tab > Units will be highlighted.
GPM < Enter > Set Units

Note: Repeat above procedure until all channels are set.

< F10 > Prior Menu

Math Channels (Trend Format)

From Edit 2500 Configuration

KEY STROKE EXPLANATION

< F9 > Math Channels and Constants*
Math Menu appears as follows:

< Fl > Math Channels
< F2 > Math Constants
< F10 > Prior Menu

Note: *This option will only appear when the Math option is fitted.

< Fl > Math Channels.
Math Channels

< � >< � > Channel will be highlighted. Select Channel Number
A05 < Enter > Type Channel Number
< Tab > Mode will be highlighted.
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< � >< � > Turn On or Off
If Off is selected, setting is complete.
If On is selected,

< Tab > Expression will be highlighted.
OO1.LT.002 < Enter > Type Expression

To edit Expression
< ♦  > Until cursor is under item to be changed
Change < Enter > Type desired change

To insert item into Expression
< ♦  > until cursor is under item to be inserted
< Ins > Type item
< Enter >

To delete an item from Expression
< ♦  > until cursor is under item to be deleted
< Del > Delete characters
< Enter >

When complete
< Tab > Left Span will be highlighted.
0 < Enter > Set Left Span (0% value)
< Tab > Right Span will be highlighted.
1 < Enter > Set Right Span (100% value)
< Tab > Units will be highlighted.
Tons < Enter > Select Units
< Tab > Channel will be highlighted.

Repeat above procedure for all Math Channels.
< F10 > Return to Math Menu

Note: For more information, refer to IM3880-60E.

Math Channels (Logging Format)

KEY STROKE EXPLANATION

< F9 > Math Channels and Constants*
Math menu appears as follows

< Fl > Math Channels
< F2 > Math Constants
< F10 > Prior Menu

Note: *This display will only appear when the Math option is fitted.

< Fl > Math Channels. Channel will be highlighted.
< � >< � > Select Channel Number or
A01 < Enter > Type Channel Number
< Tab > Mode will be highlighted.
< � >< � > Turn On or Off
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If Off is selected, setting complete
If On is selected

< Tab > Expression will be highlighted.
To enter a Math Expression

001.LT.002 < Enter > Type Expression
To edit Expression

< ♦  > Until cursor is under item to be changed
Change < Enter > Type desired change

To insert an item into Expression
< ♦  > Until cursor is under item to be inserted
< Ins > Type item
< Enter >

To delete an item from Expression
< ♦  > until cursor is under item to be deleted
< Del > Delete characters
< Enter > When complete
< Tab > Decimal will be highlighted.
< � >< � > Select Decimal point (0-5)
< Tab > Units will be highlighted.
PPH < Enter > Select Units
< Tab > Channel will be highlighted.

Repeat above procedure for all math channels.
< F10 > Return to Math Menu

Note: For more information, refer to IM3880-60E for HR2500, IM3890-60E for DA2500.

Constants
From Math Menu

KEY STROKE EXPLANATION

< F2 > Math Constants*
< � >< � > Select Constant or
K05 < Enter > Type Constant Number
< Tab > Value will be highlighted.
1.234 < Enter > Set Value
< Tab > Constant will be highlighted.

Repeat above procedure until all constants are set.
< F10 > 2 times Return to Edit HR2500 Configuration Menu.

Note: *This display will only appear when the MATH option is fitted.

Note: For more information on constants, refer to IM3880-60E for the HR2500 or IM3890-60E

for the DA2500.

Caution: The constant lE+29 cannot be set in this software. This constant must be set from the

recorder.
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End Edit

From Edit HR2500 Configuration

KEY STROKE EXPLANATION

< F10 > END EDIT

Do you wish to save your changes?

< Fl > YES
< F2 > NO

Load Configuration To Recorder

From Main Menu

KEY STROKE EXPLANATION

< F6 > Load Configuration to recorder
1 < Enter > Enter Instrument number:
Trend < Enter > Enter file name to load configuration from.

Note: When LOAD starts, an error list will appear. Data loaded into the recorder will be

displayed in the lower left hand corner of the screen.

When complete,

KEY STROKE EXPLANATION

< F10 > 2 times Return to Main Menu.
< F10 > End Program
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µR100T ◊ µR180T ◊ µR100F

Software Limitations

VARILINK™ 1.4 performs data acquisition for the µRlOOT, µR180T and µRlOOF strip chart
recorders.

The clock in the recorder cannot be accessed or set through VARILINK™ 1.4.

Requirements

1. IBM or compatible computer with an RS422;
2. DOS 2.1 or higher;
3. Johnson Yokogawa Corporation VARILINK™ 1.4 software;
4. Recorder with RS422A:

a. Refer to IM4D3B1-10E for the µRT and µRF recorders.
b. If computer is equipped with a RS232C port, a RS422A to RS232C converter is

required.

Recorder Setup

KEY STROKE EXPLANATION

< � > Turn on power to recorder while pressing < � >on the recorder door.
Refer to Parameter Display and Contents for setting information.
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Parameter Display and Contents

Character 
bit

Stop 
bit

0
1
2
3

7 bit
7
8
8

1 bit
2
1
2

**

Baudrate Parity Stop & 
Character Bit

Address
01 to 16

C o n 6 0 2 0 1

 0: 150 0: NONE **
 1: 300 1: EVEN
 2: 600 2: ODD
 3: 1200
 4:2400
 5: 4800
 6 : 9600 *

 * Recommended setting
** Required settings

KEY STROKE EXPLANATION

Baud rate character number is flashing
< � > 6 is displayed (6 = 9600)
< � > Parity character number is flashing
< � > 0 is displayed (0 = none)
< � > Stop and character bit number is displayed
< � > 2 is displayed (2 = 8 character bits, 1 stop bit)
< � > Address number is displayed (01-16)

Note: Device #1 = Address 1, Device #2 = Address 2, etc.
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l < Enter >
Settings are complete

Cycle power to recorder
Recorder is now set up for Data Display and Acquisition

Computer Setup

Boot up computer on DOS and install Johnson Yokogawa Corporation VARILINK™ software in
your disk drive.

KEY STROKE EXPLANATION

VARILINK™ < Enter > After a moment, the Main Menu will appear as follows:
< Fl > Display & Data Acquisition Menu
< F2 > Edit Configuration
< F3 > Setup Computer
< F4 > Save All Setup Parameters
< F5 > Save Configuration From Recorder
< F6 > Load Configuration to Recorder
< F7 > HR2400 IC Card
< F8 > HR2400 Reports
< F10 > End Program

KEY STROKE EXPLANATION

From Main Menu

< F3 > Set up Computer
Set up Computer

< Fl > Set up Com Ports
< F2 > Select Devices

KEY STROKE EXPLANATION

< F1 > Set up Comports

< Fl > change Com Port 1
< F2 > change Com Port 2
< F3 > change Com Port 3
< F4 > change Com Port 4

Repeatedly pressing the appropriate function key will scroll the various Baud Rate choices.
(Minimum = 300, maximum = 9600). Select the appropriate baud rate.
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Then press:

< F10 > Prior Menu.

KEY STROKE EXPLANATION

From Setup Computer Menu

< F2 > Select Devices
Select Devices

< F2 > Device Number:
< F3 > Device Type:
< F4 > Start Channel:
< F5 > End Channel:
< F6 > Interface:
< F7 > Address:
< F10 > Prior Menu:

Note: For Data Display and Acquisition, device types are limited to only those devices which are

connected to the computer. Failure to do so will create a program error. A maximum of 144

devices may be selected. A maximum of 1200 input channels may be selected.

KEY STROKE EXPLANATION

< F2 > Select Devices.
1 < Enter > Select devices menu appears. Enter number of device to be

edited.
< F3 > Device type; press < F3 > repeatedly until µRT 2 appears. Select

recorder
µRTl = µRT 1 pen µRFl = µRF 1 pen
µRT2 = µRT 2 pen µRF2 = µRF 2 pen
µRT3 = µRT 3 pen µRF3 = µRF 3 pen
µRT6 = µRT 6 point µRF4 = µRF 4 pen
µRTl2 = µRT 12 point

< F6 > Interface; press < F6 > repeatedly to select Com Port (this is the
Com Port on your computer to which you have  connected the µR
recorder, Com 1 through Com 4).

< F7 > Address; repeatedly press F7 until you reach the address set during
the recorder setup procedure.

< F10 > 3 times Return to Main Menu. The computer is now set up for
communications with the µR recorders.

< F4 > Save setup parameters.
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Display and Data Acquisition Menu

From Main Menu

KEY STROKE EXPLANATION

< Fl > Display & Data Acquisition Menu.
Setup Data Acquisition Menu will appear.

Set up Data Acquisition

< Fl > Help
< F2 > Sampling rate: (seconds)
< F3 > File name to store data to: (your file name)
< F4 > File type:
< F5 > Number of rows in data file: (samples per

channel)
< F6 > Number of columns in data file: (number of

channels)
< F8 > Save All Setup Parameters
< F9 > Start Main Program (start Display or Data

Acquisition)
< F10 > Prior Menu

Note: Spreadsheet software places a limitation on the number of columns that are available for use
in data acquisition. The limit is 250 columns or, as in VARILINK™ 1.4, a total of 250 Channels.
When the number of channels to be acquired exceeds 250, VARILINK™ 1.4 will automatically write
multiple files to disk to accommodate the excess over the 250 limit. See Example #1 below.

The ability to write multiple files simultaneously could also be used to segregate data
as desired. See example #2 below.

Example 1: Selected Device #1 is a HR2500 Hybrid Recorder with 300 channels.
All points to be saved to disk. All other selected devices are set to NA.

Set number of columns to 250, File = TEST
VARILINK™ 1.4 will save information to 2 separate files.
File #1 will be named TESTA00.WK1 (Channels 1-250)
File #2 will be named TESTB00.WK1 (Channels 251-264)

Example 2: Selected Devices 1, 2 and 3 are µR180T Dot models with 12 points
each and 36 points total. All other selected devices are set to NA.
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Set number of columns to 4, File Name = DATUM.
VARILINK™ 1.4 will save information to 3 files.
File Name #1 will be DATUMA00.WKl (Recorder #1)
File Name #2 will be DATUMB00.WKl (Recorder #2)
File Name #3 will be DATUMC00.WKl (Recorder #3)

Example 3: µR100F Pen model with 4 channels. Channels 1 & 2 in one file,
Channels 3 7 4 in a different file. Data sampled every 30 seconds.
Number of samples per point is 1000. File name = TEST.

Note: The maximum number of files that can be created is 14.

KEY STROKE EXPLANATION

< Fl > Help screen for Data Acquisition.
< F10 > To return to Set Up Data Acquisition Menu.
< F2 > Sampling rate. This setting is in seconds: minimum setting is 2

seconds, maximum setting is 21,600 seconds or 6 hours. This setting
determines how often is data saved from the recorder to the file.

30 < Enter >
< F3 > File name to store data to: Enter complete path and

your own file name with a maximum of 5 characters.
Test < Enter >
< F4 > File type - you have 2 choices: .WKl (Lotus spreadsheet format)

or .DIF (Data interchange format). This is accomplished by pressing
< F4 > (each time you press < F4 > .WKl and .DIF will toggle on the
screen).

< F5 > Number of rows in data file; minimum 500, maximum
8,180. This is the total number of samples of each acquired channel to
be stored in each file.

1000 < Enter > 1000 samples of each acquired channel will be taken before a new file
is created.

< F6 > Number of columns in data file: minimum 1 column,
maximum 250 columns. (Number of columns equals number of
channels.)

2 < Enter >
File Name #1 = TESTA00.WK1 (Channels 1 & 2)
File Name #2 = TESTB00.WK1 (Channels 3 & 4)

< F8 > Save All Setup Parameters: this will save the settings < F2
> through < F6 > to the default file for Data Acquisition.

< F9 > Start Main program. The computer screen will display
Testing Communications. Also, at the bottom left of the screen
you will observe data being read from the µRT. After approximately
one minute, Main Data Menu will appear.



VARILINK ™

µRT and µRF Recorders

IM VARILINK™ 1.4

© 1995 Yokogawa Corporation

3rd Edition, January 1995

98

 Main Data Menu

< Fl > Display Data
< F2 > Data Acquisition
< F3 > HR2400 IC Card
< F10 > Main Menu

Display Data

KEY STROKE EXPLANATION

< F1 > Display data.
 < � >< � > To scroll through channels, use these keys.
< Page Up >
< Page Down > Scrolls pages of channels.

Note: You may move directly to a given channel by typing that channel’s defined tag name.

< F10 > Return to Main Data Menu.
< F2 > Data Acquisition.

Start/Stop Data Acquisition Menu will appear. At this
point in the program, you may change any of the parameters < F2 >
through < F6 > described in the Data Acquisition Menu section
discussed earlier.

< Fl > or To start Data Acquisition.
< F10 > Return to Main Data Menu.

If < Fl > was selected
< F1 > Stop Data Acquisition when Data Acquisition is complete.

Note: The number of samples taken is displayed in the lower left portion of the screen. Also, the

name of the current file is displayed to the right of samples taken. Once a file is full, the

program will create another file automatically. A maximum of 224 files will be created.

However, if disk space is depleted, program will stop.

File creation Example: File name = Test
Current File: Test?00 will appear; once this file is full, the current file:

Test?01 will appear.

Note: After Data Acquisition is complete, the Menu will return to Start/Stop Data
Acquisition. If < Fl > is pressed and the file name has not been changed, a box will

appear under < F10 > Prior Menu: Do you want to overwrite the
existing files (Y/N). If Y is selected, the current file will be overwritten.

KEY STROKE EXPLANATION

< F10 > 2 times Return to Main Menu.
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Glossary of Terms

Alarm An instrument, such as a bell, light, printer or buzzer, that indicates
when the value of a variable is out of limits.

Baud Rate Any of the standard transmission rates for sending or receiving binary
coded data. Standard rates are generally between 50 and 19,200 baud.

Configuration A particular selection of hardware devices or software routines and/or
programs that function together.

Constant A data item that takes as its value its name (hence, its value is fixed
during program execution).

Data Acquisition A system used for acquiring data from sensors via amplifiers and
System multiplexers and any necessary analog to digital converters.

DOS Acronym for disk operating system, commonly used in personal
computers.

Handshake The recognition between two computers that they are able to
communicate.

Interpolation When performing analog recording of data, this function enables data
points to be linked by lateral line segments so as to show the continuity
of the data.

Partial Recording An important portion within the measuring range can be expanded and
recorded as desired.

Range The set of values over which measurements can be made without
changing the instrument’s sensitivity.

Stop Bit The last bit in an asynchronous serial transmission. Like the start, the
stop bit is used for timing control and carries none of the message
information.

Zones The range of input values between selected portions of a chart.




